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About this Document 
 

Preface 
 

Welcome to the BrainVoyager Getting Started Guide! This guide is used as the basis for BrainVoyager 

training courses and offers an overview of the essential basic features of the software. This guide can also 

be used as a self-study tutorial. Note that you do not have to proceed sequentially through the steps of the 

Getting Started Guide, however that files saved at an earlier step are needed at later stages for data 

analysis. BrainVoyager is a 64-bit program available for several computer platforms currently supporting 

Windows 10, Mac OS 10.12 or higher, and most 64-bit Linux distributions using a 3.x or newer kernel running 

on recent Intel/AMD machines.  

If you would like to learn how to use BrainVoyager, please use the freely available educational version, 

BrainVoyager EDU. This version works only with predefined training data sets, such as the Getting Started 

Guide data, but provides the same functionality as the full version, see 

http://brainvoyager.com/products/brainvoyageredu.html for more details. 

 

This guide has been prepared with the Windows version of BrainVoyager EDU, but it can also be used for 

learning the program with the full version and on any of the other supported operating systems. Take your 

time going through the steps. If the steps you are performing are not making sense to you, consider 

repeating some previous steps. In the beginning all actions will be explicitly written out, in later steps, 

acquired knowledge is needed to complete the steps. 

 

 

Data 

 

You can find the PDF version of this guide in the “GettingStartedGuides” folder of your BrainVoyager 

directory in the Users folder, e.g. C:\Users\<USER>\Documents\BrainVoyager\GettingStartedGuides. 

 

The respective data for the example dataset can be found on our website: 

http://download.brainvoyager.com/bv/GSGData.zip 

Please extract all files to the following folder (replace <USER> with your login name): 

 

Windows: “C:/Users/<USER>/Documents/BrainVoyager/SampleData/GSGData”  

Mac OS X: “/Users/<USER>/Documents/BrainVoyager/SampleData/GSGData”  

Linux: “/home/<USER>/Documents/BrainVoyager/SampleData/GSGData” 

 

 

How to use the Getting Started Guide 
 

Bold 

Bold body text indicates that you should perform an action. 
 
“File” -> “New Document” 
This style indicates that you should use the respective menu entries (here File and New Document). 

 
Information or fields that require special attention will be marked by red boxes 

 

 

We hope you will enjoy working with BrainVoyager as much as we do. We are grateful to many BV users 

for helping us to improve this guide. 

If you have any questions, don’t hesitate to contact us at: support@BrainVoyager.com. 
 
Sincerely yours, 

Judith Eck, Armin Heinecke, Caroline Benjamins, Henk Jansma, Hester Breman and Rainer Goebel 

  

http://brainvoyager.com/products/brainvoyageredu.html
http://download.brainvoyager.com/bv/GSGData.zip
mailto:support@BrainVoyager.com
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The “Faces-Houses-Left-Right-Center” Tutorial 
 

This tutorial gives an introduction into essential data processing steps with BrainVoyager. The focus is on 

getting you started in using the program quickly and easily. The tutorial uses NIfTI data from a simple block 

design which was acquired in a multi-run and multi-session experiment. The acquisition of the ‘Faces-Houses-

Left-Right-Center’ data was followed by another functional run which is not used in the present guide. After 

this second functional run, 5 volumes with reversed phase-encoding direction and otherwise identical 

acquisition parameters have been acquired for the option to apply distortion correction in the functional 

preprocessing pipeline (see https://support.brainvoyager.com/brainvoyager/available-tools/86-available-

plugins/62-epi-distortion-correction-cope-plugin for more details). This was followed by the intra-session 

anatomical 3D scan (T1, MPRAGE). The data has been organized following version 1.1.1 of the Brain Imaging 

Data Structure (BIDS) (see http://bids.neuroimaging.io/ and https://doi.org/10.1038/sdata.2016.44). The “anat” 

folder contains the intrasession structural scan (sub-01_ses-04_acq-nondistorted_T1w*). The functional data 

is located in the “func” folder (sub-01_ses-04_task-blocked_run-1_bold*), which also contains the onset, 

duration (in seconds) and trial type definition of the experimental stimulation blocks (sub-01_ses-04_task-

blocked_run-1_events.tsv).  

 

──SampleData 

│   └───GSGData 

│       │   dataset_description.json 

│       │ 

│       └───sub-01 

│           └───ses-04 

│               ├───anat 

│               │       sub-01_ses-04_acq-nondistorted_T1w.json 

│               │       sub-01_ses-04_acq-nondistorted_T1w.nii.gz 

│               │ 

│               └───func 

│                       sub-01_ses-04_task-blocked_run-1_bold.json 

│                       sub-01_ses-04_task-blocked_run-1_bold.nii.gz 

│                       sub-01_ses-04_task-blocked_run-1_events.tsv 

 

 

 

The experimental block design is described in the next section. 

 

 
 

The Faces-Houses-Left-Right-Center Experiment 
 

 

 

Black and white images of faces and houses subtending 4.7° by 4.7° 

were presented alternately in the left visual field, the right visual field or in 

the center of the visual field (see figure), resulting in six different 

experimental conditions. Each stimulation block lasted 16 seconds and 

was repeated three times within a run. Stimulation blocks were separated 

by “fixation blocks” of equal length. In a fixation block, only a cross was 

shown, which the subject had to fixate. 
 
 
 
 

  

https://support.brainvoyager.com/brainvoyager/available-tools/86-available-plugins/62-epi-distortion-correction-cope-plugin
https://support.brainvoyager.com/brainvoyager/available-tools/86-available-plugins/62-epi-distortion-correction-cope-plugin
http://bids.neuroimaging.io/
https://doi.org/10.1038/sdata.2016.44
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Scanning Session Information 
 

 

Experiment: Faces Houses in LVF, CVF, RVF  Stimulation Protocol 

Session: ses-04  (blocked design, one run,  

Subject: sub-01  *events.tsv) 

     

   Volume nr Condition name 

Conditions: Fixation  1 - 3 Fixation 

 Faces in LVF (Left Visual Field)  4 - 11 Faces_LVF 

 Faces in RVF (Right Visual Field)  12 - 19 Fixation 

 Faces in CVF (Central Visual Field)  20 - 27 Houses_RVF 

 Houses in LVF   28 - 35 Fixation 

 Houses in RVF   36 - 43 Faces_CVF 

 Houses in CVF   44 - 51 Fixation 

   52 - 59 Houses_LVF 

   60 - 67 Fixation 

Acquisition Parameters:  68 - 75 Faces_RVF 

NrOfSlices: 64 (multiband sequence, factor: 2)  76 - 83 Fixation 

SliceThickness: 2 mm  84 - 91 Houses_CVF 

FoV: 200 mm x 200 mm  92 - 99 Fixation 

Matrix: 100 x 100  100 - 107 Faces_LVF 

NrOfVolumes: 291  108 - 115 Fixation 

TR: 2000 ms  116 - 123 Houses_RVF 

   124 - 131 Fixation 

   132 - 139 Faces_CVF 

   140 - 147 Fixation 

   148 - 155 Houses_LVF 

Intra-session structural scan (T1)  156 - 163 Fixation 

NrOfSlices: 192  164 - 171 Faces_RVF 

   172 - 179 Fixation 

   180 - 187 Houses_CVF 

   188 - 195 Fixation 

   196 - 203 Faces_LVF 

   204 - 211 Fixation 

   212 - 219 Houses_RVF 

   220 - 227 Fixation 

   228 - 235 Faces_CVF 

   236 - 243 Fixation 

   244 - 251 Houses_LVF 

   252 - 259 Fixation 

   260 - 267 Faces_RVF 

   268 - 275 Fixation 

   276 - 283 Houses_CVF 

   284 - 291 Fixation 
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Part I: Analysis in Original Space - FMR-STC Documents 
 

Step 1: Launching BrainVoyager and Opening Functional NIfTI Files 
 

In this step we will learn how to launch BrainVoyager and create functional documents from NIfTI files using the 
NIfTI import. The Neuroimaging Informatics Technology Initiative (NIfTI) file format has been proposed by the 
Data Format Working Group (DFWG) to facilitate the exchange of neuroimaging data across software packages 
and is supported for data import and export in BrainVoyager. You can find more information about the use of 
NIfTI files in BrainVoyager in the User’s Guide.  
 
Please note: that you can also create functional documents in BrainVoyager from DICOM files via the “New 
Document Wizard” or the “New Document” dialog as described in Appendix B: Creation of a Functional Document 
From DICOM Files. 
 

1. Launch BrainVoyager EDU by clicking the “BrainVoyager EDU” icon.  
Alternatively, launch the full version by clicking the “BrainVoyager” icon. 

 

2. After opening BrainVoyager EDU, you will see a “Welcome” window giving you the opportunity to load different 
guides with corresponding example data sets that introduce you to the basic features of the software. Please 
click on the “Getting Started Guide“ button to see the PDF version of the guide while working in BrainVoyager 
EDU. 

 

 

 

Please note: In BrainVoyager you will see a different “Welcome” screen that provides you with additional 
information via the “Getting Started” link. Both the EDU and the full version of BrainVoyager give you the 
option to reload all files used in the previous session by selecting the respective option in the “Welcome” 
screen. After clicking the “Accept” button the “Welcome” window of BrainVoyager is closed. 
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BrainVoyager consists of the main documents window, a menu bar, one horizontal and one vertical toolbar 
and a status bar. The usage of the icons in the toolbars will be described in later steps. 
 

 
 
Within the horizontal icon toolbar you can see 5 pane icons to activate: 

 
a) the “Recent Files Pane”, allowing quick access to recently opened files, 
b) the “Info” and “Log Pane”, providing information about various analysis steps (i.e. document creation, 

coregistration) 
c) the “Open Docs Pane”, providing a preview of all open documents 
d) the “Zoom View Pane” 

 

3. Some global preferences, e.g. the graphical user interface and the layout, can be set in the “Preferences” 

menu. This menu can be found by clicking the “Settings” icon in the toolbar (or via “File” -> “Settings”).  

 

4. After you have opened BrainVoyager for the first time, you might see a message in the “Log Pane” stating 
that “OpenCL is available but NOT used!”. BrainVoyager supports OpenCL (GP-GPU) acceleration for several 
compute-intensive operations, if supported by your computer. If you see a message, as stated above, make 
sure that you go to “File” -> “Settings”, switch to the “Speed” tab and turn on OpenCL acceleration for “Sinc 
interpolation” and “Sigma filter” as indicated in the next screenshot. For more information please consult the 
User’s Guide via the “Help” button in the “Preferences” window.  



Step 1: Launching BrainVoyager and Opening Functional NIfTI Files 

6

 

 

5. Now we can create a functional document in BrainVoyager by importing the NIfTI data of a functional run. 
Click on the “Open NIfTI” icon in the horizontal toolbar or go to “File” -> “Open NIfTI…”. 

 

 

Navigate to “\Documents\BrainVoyager\SampleData\GSGData\sub-01\ses-04\func” and select the file “sub-
01_ses-04_task-blocked_run-1_bold.nii.gz”. Please click on “Open” to create an “FMR” document in 
BrainVoyager. An “FMR” document (FMR = Functional Magnetic Resonance) stores the imaging data 
belonging to one functional run.  

 

 

 

6. After the FMR creation has been completed, you will see the resulting document as well as several new 
information windows. In a functional recording the brain is scanned repeatedly over time, but BrainVoyager 
will visualize only the 64 slices of the first volume of the created document. The data of the repeated 
measurements of the brain, as it is scanned volume by volume during the execution of the “Houses - Faces” 
experiment, are stored on disc in a single STC (slice time course) file. The resulting files are saved in the 
“derivatives” folder of the project, i.e. “SampleData\GSGData\derivatives\sub-01\ses-04\func”. The name of 
the FMR document is automatically determined by the name of the NIfTI file, i.e. “sub-01_ses-04_task-
blocked_run-1_bold.fmr”. 
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7. The FMR document file is a simple text file, which contains a link to the STC-file and other useful information. 

After the creation of the FMR document, the “FMR Properties” dialog, shown below, is opened automatically. 
This dialog allows you to inspect and modify the relevant information of the FMR document. You can call this 
dialog at any time via the menu item: “File” -> “Document Properties” -> “FMR Properties...”. 
 

 
 

8. You might have noticed that BrainVoyager has opened automatically relevant information from the NIfTI 
header of the selected file. This information has been used to store relevant information in the FMR header 
for preprocessing of the functional dataset. The first value of the “dim” entry indicates that it is a 4D dataset, 
with a matrix size of 100 x 100 (2nd and 3rd value), 64 slices (4th value) and 291 volumes (5th value). Values 2 
– 5 in the “pixdim” entry indicate the inplane resolution, the slice thickness and the time to repeat (TR) in 
seconds. Use this information to check the entries made in the FMR Properties. Click on “Options” in the 
“Voxel resolution definition” field to see the “Matrix size”. 
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For statistical analysis of the data, we will use a model of the hemodynamic response function (HRF) in a 

later step. To correctly apply the HRF model and for temporal preprocessing, correct timing information of 

the functional recording has to be supplied. When opening a NIfTI file in BrainVoyager it checks whether a 

JSON sidecar file with the same name exists in the folder, if so, it is automatically read and displayed in a 

new information window, see below. The JSON file provides additional metadata not stored in the NIfTI 

header, as for example the slice timing in seconds with respect to the volume onset. This information is 

especially important for the slice scan time correction. As this NIfTI file was created with the “Create 

Document Wizard” in BrainVoyager, it contains a “BrainVoyagerInfo” entry that stores information specific to 

BrainVoyager, i.e. information that is usually stored in the header of the FMR. Explore the information of the 

JSON file and see whether you can find the “SliceTiming” information.  

 

 
 

If the “Verified” options are not checked in the “FMR Properties”, it is important to check the corresponding 

entries. In our example, you can find the scanning parameters in the “Scanning session information” provided 

in the beginning of this guide. When the values in the “FMR Properties” are correct, click the “Verified” 

checkbox. This will automatically save the FMR document to disk with the updated values. 
 
 
 

You can now move on to Step 2. 
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Step 2: Change Layout and Display Options 
 

In this step, we will learn how to change the layout of an FMR document. 
 
 
1. If you have closed BrainVoyager EDU, start 

the program now and open the document 
“sub-01_ses-04_task-blocked_run-
1_bold.fmr”. Alternatively, all documents 
used in the previous session will be opened 
automatically if you select the “Reload Last 
Session” option in the “Welcome” window of 
BrainVoyager EDU. 
 
 
 
 
 

2. In this example an 8 x 8 layout of the 64 slices is presented, since BrainVoyager attempts to arrange the 
slices in an optimal way. If you would like to change the way BrainVoyager has arranged the images, you 
can use the “Decrease Columns/Rows” and “Increase Columns/Rows” icons to change the layout (see 
below).  
 
Note: BrainVoyager will initially show documents in a maximized state. You may also display document 
windows in a smaller size than the workspace window by using “Window -> Sub-Window View Mode”. You 
may then adjust the display size of the window by moving the mouse to the right lower corner of the window 
until the cursor changes to a resize shape. Then click+drag the window to the size of your choice. You may 
notice that the program keeps the aspect ratio of the window constant. This ensures that pixels are displayed 
as squares. To go back to the maximized document mode, click the sub window’s “Maximize” icon. 
 

 
 
 

 
3. Click the “Increase Columns” icon to see more columns of 

slices. Since the layout is also saved in the FMR file, you can 
permanently keep desired layout settings by saving the file, 
either by clicking the “Save” icon or by using the “File -> 
Save” menu item. 
 

4. Click the “Image Border” toggle to enable or disable drawing 
of separating lines between slices. 

 
 

5. Click and Drag while holding “Alt” to zoom in a part of one 
or several of your slices. 

  

Show / Hide 3D Volume Tools dialog 

Show / Hide Border 

Decrease Columns 

Increase Columns 

Decrease Rows 

Increase Rows 

Decrease Threshold 

Increase Threshold 

Adjust Window size 
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6. You can use the “Page Down” (or Right Arrow) and “Page Up” (or Left Arrow) keys to scroll through the slices. 
This is convenient if you want to inspect only a single or a few slices. You can zoom in a single slice without 
changing the layout by right-clicking the respective slice while holding down the “CTRL” key. Use the same 
command to go back to the matrix layout. 
 

7. BrainVoyager also offers another way to change the layout, by means of the “Layout And Display Options” 
dialog. You can call this dialog by clicking the “Layout...” button in the “FMR Properties” dialog or via the 
menu “Options -> Layout And Display Options ...”. Use the respective entries to adjust the display to your 
needs. 

 

 

 

8. BrainVoyager allows to change the brightness and contrast of the displayed first volume of the FMR. The 
example dataset is very bright. By increasing the contrast and decreasing the brightness the visualization of 
the structural information in the image will be improved. You can invoke the “Contrast and Brightness” dialog 
via “Options”-> “Contrast and Brightness”.  

 

  
 
 
 

You can now move on to Step 3. 
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Step 3: Creation of the Protocol 
 

In this step we will learn how to create protocol files. These files contain information about the experimental 

design of the functional run. As you will see, these files play an important role in BrainVoyager, simplifying many 

tasks such as the specification of statistical analyses. 

 

1. Make sure the “sub-01_ses-04_task-blocked_run-1_bold.fmr” file is open. 

2. For the current example dataset a stimulation protocol has been created already and was saved in a .tsv file 

following the BIDS standard (http://bids.neuroimaging.io/). The “sub-01_ses-04_task-blocked_run-

1_events.tsv” file is in the same folder as the original functional NIfTI file and specifies the onset and duration 

of each trial in seconds as well as the name of the trial. When importing functional NIfTI files, BrainVoyager 

checks whether an *_events.tsv file with the same name as the NIfTI file exists in the same folder and if so, 

automatically creates a protocol file and links it to the resulting FMR document. You can see the link to the 

protocol file in the FMR properties. 

 

 

 

3. In order to learn how a protocol is created from scratch in BrainVoyager, remove the link to the current FMR 

document by clicking “Detach” in the “Referenced protocol (PRT) file” field of the “FMR Properties”.  

4. We will now define the Protocol file for the current experimental run. You can find a definition of the protocol 

at the beginning of this tutorial, see the Scanning Session Information. Click the “Protocol...” menu item in the 

“Analysis” menu to invoke the “Protocol” dialog.  

5. Provide a name for the experiment by entering “Faces Houses in LVF, CVF, RVF” in the “Experiment name:” 

field. 

 

 

 

Info: If you want to edit the protocol after it has been saved, you can also open the dialog by clicking the “Edit” 
button in the “Referenced protocol (PRT) file” field of the “FMR Properties” dialog. 

  

http://bids.neuroimaging.io/
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6. We have to define six conditions, “Faces_LVF”, “Houses_RVF”, “Faces_CVF”, “Houses_LVF”, “Faces_RVF” 
and “Houses_CVF”. To define the first condition, click the “Add” button on the right side of the “Condition 
list”. You will see “<untitled>” in the “Condition list”. Select “<untitled>” and then click “Edit Name”. 
Alternatively, you may double click the condition name. Change the name of the first condition to 
“Faces_LVF” and then press the <RETURN> button. 

 

 

 

7. Click the “Intervals >>” button to show the interval definition fields.  

 

 

 

8.  There are two ways to specify a protocol: 

a. specifying the intervals numerically (the onset and offset of a condition) or 

b. using a graphical procedure based on a segmented visual representation of time.  

We use the latter method, which works well with regularly spaced conditions as in our example. 

 

 

 
9. Choose the condition “Faces_LVF” from the “Condition list”. Click the “Show Plot” button to call the “Time 

Course Plot [Protocol]” dialog. This dialog shows segments (vertical lines) in units of 10. 
 

 
 

Note: When the segmentation lines are not visible, click the “Show grid” option. 
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10. Click the spin buttons of the “Size” field to change its value to “8”. This changes the time course 
segmentation to the correct width in volumes with respect to our condition duration. 
 

 
 
Enter “3” in the “Offset” field. This is necessary because there are three baseline data points before the 
first main condition starts. 
 

11. Click with the left mouse button in all segments belonging to the “Faces_LVF” condition as shown below. 
 

 
 

12. Click the “Add To PRT” button. This will convert the graphical specification of intervals into a numerical 
representation, which will be added to the protocol. Note that the intervals defined in the “Time Course 
Plot” dialog are added to the “current” condition, which is the one highlighted in the “Protocol” dialog. 
 

 
 

When a condition has been defined, the “Time Course Plot” window automatically selects the “Show 
protocol” option in order to present the stimulation protocol defined so far. In our case, we see several grey 
vertical bars representing the intervals of the “Faces_LVF” condition. 
 

13. Add the next condition by clicking the “Add” button on the right of the “Condition list”. Change “<untitled>” 
to “Houses_RVF”. Make sure that the “Houses_RVF” condition is selected in the “Condition list” and click 
in the intervals belonging to this condition in the “Time Course Plot” window as indicated below.  
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14. Click the “Add To PRT” button in the “Time Course Plot” window. 
 

15. Add the condition “Faces_CVF” in the same way as the previous condition. Make sure that the “Faces_CVF” 
condition is selected in the “Condition list” and click in the intervals belonging to this condition in the “Time 
Course Plot” window. 
 

 
 

16. Click the “Add To PRT” button in the “Time Course Plot” window. 
 

 
 

17. Add the remaining three conditions: “Houses_LVF”, “Faces_RVF” and “Houses_CVF” in the same way. 

 
Note: After having defined all conditions, you may want to deselect the “Show grid” option in the “Time 
Course Plot” dialog since we do no longer need the grid lines. 
 

 
 

18. We now change the display color of our conditions. In the “Condition list”, click on the “Faces_LVF” 
condition and then on the “Edit Color” button. In the appearing “Select Color” dialog, change the “Red” 
value to 200 and the “Green” and “Blue” values to “43”. Click “OK” to accept the new color. 
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Note: If you work on Mac, you can find the RGB colors as presented in the 
screenshot on the right. 
 

19. Next click on the “Houses_RVF” condition and then again on “Edit Color”. Change 
the color for this condition to yellow by entering the values “200”, “200” and “43” in 
the “Red”, “Green” and “Blue” fields. Click “OK” to accept the new color. 
 

 
 

20. Click on the “Faces_CVF” condition and then again on “Edit Color”. Change the color 
for this condition to green by entering the values “43”, “200” and “43” in the “Red”, 
“Green” and “Blue” fields. Click “OK” to accept the new color. 
 

  
 

21. Change the condition “Houses_LVF” to the RGB value 43, 200, 200, the condition “Faces_RVF” to the RGB 
value 43, 43, 200 and the condition “Houses_CVF to 200, 43, 200. 
 

22. If you now see a screen like the one below, you have successfully created the stimulation protocol! 
 

 
 
Exercise: There are further possibilities how you can adapt the appearance of the protocol as well as the 
time course plot. Check out these features by clicking the “Options” button. 
 

23. Save the protocol to disk under the name “sub-01_ses-04_task-blocked_run-1_events.prt” by using the 
button “Save.PRT...”. The protocol is now temporarily linked to the FMR document. To permanently keep 
that link, save also the “sub-01_ses-04_task-blocked_run-1_bold.fmr” document by clicking the “Save” 
icon in the menu bar. You may now close the “Protocol” dialog by clicking the “Close” button. 
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Note: The consistency of your protocol definitions is constantly checked in the background. The result of 
this consistency check is shown in the title bar of the “Protocol” dialog. If “OK” appears, your protocol is 
fine. If, however, “NOT OK” is shown, your protocol contains overlapping condition intervals and you must 
change the protocol. 
 

 

 

 

 

You can now move on to Step 4. 
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Step 4: Statistical Tests and Time Courses 
 
In this exercise, we will learn how to run statistical tests. We will also learn how to inspect time courses of regions-
of-interest (ROI’s). 
 
1. If you have closed BrainVoyager, start the program now and open the document “sub-01_ses-04_task-

blocked_run-1_bold.fmr”. 
 

2. If you did not start this Getting Started Guide from step 1, check if the correct TR is saved in the FMR file. 
You can check this information in the “FMR Properties” dialog, which should open automatically. If this is 
not the case, select the “File -> Document Properties -> FMR Properties” menu item. If necessary, enter 
the value for the “TR”. Then click the “Verified” checkbox to tell the program to use this value. 
 

 
 

3. Select “Compute Linear Correlation Maps” in the 
“Analysis” menu. This will invoke the “Linear 
Correlation” dialog. 

 
 
 
 
 
 
 
4. We want to compare the condition “Faces_LVF” to the baseline, i.e. the part of the experiment in which 

subjects were only fixating. This “Fixation” condition was not explicitly defined in the Protocol but is implicitly 
represented by all non-defined time intervals in the run, i.e. the black intervals in the time course 
representation. Please change the “Offset” and “Size” value to 3 and 8, respectively, so that the correct 
condition duration is represented in the time course segmentation. To design a respective “box-car” function 
for this test click with the right mouse button in one of the red vertical segments and with the left mouse 
button in all black vertical segments. 
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5. Click the “HRF” (hemodynamic response function) button, which will modify the box-car function to account 
for the hemodynamic delay. 
 

 
 
Note: The “HRF” button will apply a two-gamma hemodynamic response model. If you would like to change 
the default parameters of the Two- Gamma HRF, change these values in the “Linear Correlation Options” 
dialog by clicking the “Options” button. Note that it is normally not recommended to change these values. 
 

 
 

6. Click the “GO” button to run the specified statistical test. The specified reference time course is now 
correlated with the time course at each pixel of all slices. The results of all individual tests are saved 
internally in a statistical map which is shown on top of the slices. Those pixels surpassing a specified 
statistical threshold are shown in red or yellow for a positive correlation and in light and dark blue for a 
negative correlation. Pixels colored yellow and light blue have obtained a value close to the threshold value 
while pixels colored in red and dark blue have obtained a statistical value, which is substantially higher than 
the threshold value. 
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On the right you see the result of the 
correlation test for slices 14 and 15. 
There are only a few pixels in orange 
color, which surpassed the default 
threshold of a correlation of 0.32 or 
greater. This threshold is shown on 
the left side of the color bar. Note that 
the statistical values next to the color 
bar are only visible if the FMR is 
zoomed. 
Change the layout in such a way that 

only slices 14 and 15 are visible in a 

zoomed state as shown on the right 

(see Step 2: Change Layout and 

Display Options). 

 

Below the color bar the text “r(169)” indicates the statistical test performed (“r” -> correlation) together with 
the “degrees of freedom” of the test “169”. The latter value is required to compute a probability value “p”, 
which indicates the “significance” of the test. The “p” value is shown in the right lower corner. BrainVoyager 
uses the “False Discovery Rate” (FDR) to determine the default threshold. This approach provides 
thresholds corrected for multiple comparisons. The FDR threshold is shown on top of the color bar as 
“q(FDR) < 0.05”. For details on the FDR method, check the User’s Guide. 

 

7. The standard statistical threshold is high, so only few “active” pixels can be 

seen. To lower the statistical threshold, click the “Decrease Threshold” icon 

in the toolbar. Observe slices 14 and 15 while clicking the icon repeatedly 

(i.e. 10 times). You will see more extended brain activation in the right 

hemisphere. Note that the right hemisphere is shown on the left side! 

 
The observed lateralized activity is 
expected from knowledge of the visual 
system. Our statistical test has asked the 
question “Where does the brain respond 
to face images presented in the left 
visual field?”. The answer given in form 
of a statistical map is “Areas mainly in 
the visual cortex of the right 
hemisphere”. 

 
 
 
 
 
 
8.  Now we want to see the time course of 

a particular brain region of interest (ROI 

= region- of-interest). This can be done 

easily by drawing a rectangle around the 

ROI. Click the left mouse button down at 

a point where you want to start drawing 

a rectangle. Keep the mouse button 

pressed and move the mouse pointer 

down and to the right until the ROI is 

located within the rectangle. Release the 

mouse button. You will see a green 

rectangle. In addition, a new dialog 

window pops up showing the “ROI Signal 

Time Course”. This window shows time on the X axis (in measured scans) and the fMRI signal on the Y 

axis. 

 

Note: When a protocol file is linked to the FMR, the y axis of the “ROI Signal Time Course” represents the 

percent-normalized fMRI signal as calculated using the baseline points derived from the stimulation 

Decrease Threshold 

Increase Threshold 
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protocol. If no protocol is available, the raw fMRI signal is presented on the y axis of the time course window. 
 
9. The time course window might be shown initially a bit small. You can adjust the display size of the window 

by moving the mouse to the lower bottom of the window until the cursor changes to a resize shape. Then 
click+drag the window to the size of your choice. 

 
Remark: The time course window shows the mean time course of all “active” pixels falling within the specified 
rectangle. 

 
Note: You can also save the selected ROI by using CTRL+R, which invokes the “Region-Of-Interest” dialog. 
After clicking the “Save...” button you have to specify the target folder and the name of the ROI. 
 

 
 

10. As an exercise, inspect additional ROI time courses. If you draw a new rectangle, the previous rectangle is 
deleted and the “ROI Signal Time Course” window shows the time course for the newly selected ROI. Thus, 
there is only one ROI Signal Time Course window visible. You can, however, see the time courses of more 
than one ROI at the same time by using the CTRL key. Press the CTRL key and hold it down, then draw 
the rectangle around a ROI as usual. This will invoke a new “ROI Signal Time Course” window as shown 
below 
If you have invoked several time course windows, you can keep track which ROI belongs to which window 
by looking at the color of the square at the left lower corner of the “ROI Signal Time Course” window as 
shown below. 
 

 
 

11. To close a “ROI Signal Time Course” window, click the “Close” icon (“x”) on the right side of the title bar. 
 
 
 

You can now move on to Step 5. 
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Step 5: Preprocessing of FMR Documents 
 

In this exercise, we will preprocess the functional MRI data, i.e. the FMR document. This is an important step 
in improving the power of statistical tests, i.e. by removing drifts in signal time courses and by removing head 
motion artifacts. To get a “feeling” about the effects achieved by preprocessing, we will run the same statistical 
test as described in step 4 after the preprocessing is finished. 

 

1. If you have closed BrainVoyager, start the program now and open the document “sub-01_ses-04_task-
blocked_run-1_bold.fmr”. 

2. Preprocessing requires information about the spatial and temporal resolution of the data. If you have not 
checked this information in previous steps, you can do this now by inspecting the time and voxel resolution 
values in the “FMR Properties” dialog. If this dialog has not opened automatically, you can invoke it by 
clicking the “FMR Properties“ item in the “File” menu. As an alternative, you can also change the time and 
voxel resolution values (if necessary) in the “FMR Data Preprocessing” dialog. 
 
 

3. To improve the quality of the data, we will preprocess it. Select 
“FMR Data Preprocessing...” in the “Analysis” menu. This will 
invoke the “FMR Data Preprocessing” dialog. 
 

4. There are several preprocessing options like “Slice scan time 
correction”, “3D motion correction” and so on. You can run 
several preprocessing options at once. The standard settings 
of BrainVoyager offer good results, and do not include spatial 
and temporal smoothing. 
 
 
 
 
 
 

Note: It is recommended to preprocess the data as much as necessary but as little as possible. For individual 
data analysis we recommend to first inspect the data without spatial smoothing and if desired add spatial 
smoothing later in volume time course (VTC) space via “Analysis -> VTC Data Preprocessing…” (for an 
introduction into VTC space see Part II of this guide). 
 

5. To see further information/options about preprocessing tools, 
click the “Advanced_>>” button which will show an extended 
“FMR Data Preprocessing” dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
The expanded dialog shows more detailed information about the chosen preprocessing options: slice scan 
time correction and 3D motion correction will be performed on our functional data; in addition, linear (and 
non-linear) trends (“drifts”) in the data will be removed. Detailed information on the different parameters are 
described in the section “Preprocessing of Functional Data” in the User’s Guide and are set to reasonable 
values automatically.  

 
6. Click the “GO” button to run the specified preprocessing options. A “Progress” dialog will appear, which 

informs you about the state of preprocessing. Additional information about the current preprocessing step 
will be printed to the log tab. 
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Parameters used during preprocessing are included in the name of the resulting file. In our case, the 
explanation of the abbreviations in the file name is as follows: 

 
sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr 
 

Temporal High Pass (GLM Fourier) 
with 3 cycles / points 

 

3 D Motion Correction with Trilinear 
estimation and Sinc interpolation 

 
Slice Scan time Correction, Cubic 
spline Interpolation, using the Slice 
Time TaBLe information 

 
 
You will find more information regarding different preprocessing options in the BrainVoyager User’s Guide 
and on our support website http://support.brainvoyager.com 
 

7. After preprocessing has been completed, BrainVoyager automatically opens the preprocessed FMR 
document called “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr”. 

  

http://support.brainvoyager.com/
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BrainVoyager shows a graphical representation of the ongoing 3D motion correction. A specified volume 
serves as the reference (the first as default) to which all other volumes are aligned in space by rigid body 
transformations. The detected head motion of a volume with respect to the reference volume results in 3 
translation and 3 rotation parameters. These detected values are used to translate and rotate the respective 
volume accordingly to correct for the detected head motion. During 3D motion correction, the six estimated 
parameters are displayed incrementally in a time course graph (see below). The 3 translation and 3 rotation 
parameters are color-coded as follows: 
 
 
Red: -> Translation in X direction,  
Green: -> Translation in Y direction,  
Blue: -> Translation in Z direction,  
Yellow: -> Rotation around X axis,  
Magenta: -> Rotation around Y axis,  
Cyan: -> Rotation around Z axis. 
 
 
 
 
 
Note that the axes are defined in image space (i.e. not in Talairach or MNI space): X refers to the image 
left-to-right direction, Y refers to the image top-to-bottom direction and Z refers to the direction across slices 
(first-to-last slice). The display can be altered in the same way as the Event-Related Averaging plot window, 
which will be described in Step 8. You can access these options by clicking with the left mouse button in 
the plot.  
 

8. To check the quality of the performed motion correction, BrainVoyager automatically opens a difference 
image obtained by subtracting the last from the first functional volume of the same FMR before (upper row) 
and after motion correction (lower row). By clicking on the “Play” button in the “Animation Player window” 
one can see a movie showing the first and last volume in rapid succession which gives a good impression 
of the amount of residual brain motion. The same movie is automatically saved to disk in Google's "webp" 
format: sub-01_ses-04_task-blocked_run-1_bold_MotionCorrection.webp. Close the Animation Player via 
the “Close” button.  
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9. It is advised to inspect the data before and after preprocessing. For that purpose, please open the “Time 
Course Movie” dialog via “Options -> Time Course Movie…”  
 

 
 
When clicking the “First <-> Last” button, BrainVoyager will alternate between showing the first and the 
last volume of the FMR, which is another way of checking the amount of motion in this functional run. If you 
do not see any difference in the spatial location of these volumes, i.e. no “flickering” in the edges of the 
slices, motion correction was successful. By clicking the “play” button one can check all volumes of that 
run for signal dropouts or other data quality problems. Close the dialog via the button “Close”.  
 
Note: As you can see in the 3D Motion Correction Plot, the subject has moved only minimally in this 
functional run. When you do have data sets with more motion, the effect of motion correction will be even 
more pronounced. 

 
Exercise: To see the effect of preprocessing on the statistical results, run the same correlation test as in 
step 4 for both the original and preprocessed data and also inspect the time courses of the same ROI’s as 
in step 4. Try to reproduce the layout shown on the next page. 
 

  
 

 
 
 
You will see that the statistical map looks slightly different after preprocessing, since preprocessing has 
removed noise in the data and hence has increased sensitivity of the statistical tests. In addition, the time 
course shows that there are no more drifts in the data due to the removal of linear and nonlinear trends. 
 
 

You can now move on to Step 6. 
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Step 6: Statistical Analysis with the General Linear Model (GLM) 
 
In this exercise, we will use the General Linear Model (GLM) to analyze the data. The GLM goes beyond simple 

correlation or t-tests by allowing to specify advanced statistical models containing many explanatory variables 

also called “predictors”. A specified model is “fitted” to the time course of each voxel resulting in a “t”, “F” or “R” 

value telling us how well the overall model explains the time course. In addition, the fit tells us whether one or 

more individual explanatory variables contribute significantly to the explanation of the voxel time series. It is also 

possible to test contrasts, i.e. whether the estimated effect (beta weight) of a predictor A is significantly larger 

(or smaller) than the estimated effect of a variable B. 

 
 
1. If you have closed BrainVoyager, start the program now and open the document “sub-01_ses-04_task-

blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr”. 
 
 
2. Select “General Linear Model: Single Study...” in the “Analysis” 

menu. This will invoke the “Single Study General Linear Model” 
dialog. 

 
 

Note: For more details about the GLM consult the topic “The 
General Linear Model (GLM)” in the section “Statistical Data 
Analysis” of the BrainVoyager User’s Guide. 

https://download.brainvoyager.com/bv/doc/UsersGuide/Statisti
calAnalysis/TheGeneralLinearModel.html 

 
 
 
3. We want to specify a model with six predictors reflecting our six main conditions “Faces_LVF”, 

“Houses_RVF”, “Faces_CVF”, “Houses_LVF”, “Faces_RVF” and “Houses_CVF”. The “Predictors” field tells 
us that the dialog is already prepared for entering the first predictor.  
 

 
 
We can enter the reference function for the first predictor with the mouse: Click with the right mouse button 
in one of the red vertical bars to define the first predictor. 
 

 
 
Note that the predictor “Name:” field is automatically set to the name of the corresponding condition, 
“Faces_LVF”. 
 

https://download.brainvoyager.com/bv/doc/UsersGuide/StatisticalAnalysis/TheGeneralLinearModel.html
https://download.brainvoyager.com/bv/doc/UsersGuide/StatisticalAnalysis/TheGeneralLinearModel.html
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4. Click the “HRF” button, which will modify the reference function to account for the hemodynamic delay of 
the fMRI signal. 
 

 
 
Note: You can also use the “Condition list” on the right side to specify the reference function, by clicking 
with the right mouse button on the name of the condition that you would like to specify as a predictor.  

 
5. We now want to enter the second predictor for the “Houses_RVF” condition. Click the “Add Pred” button to 

create a new empty time course for entering the second predictor. In the “Predictors” field, you will now see 

the entry “2 / 2”, which indicates that we currently see the time course of predictor 2 and that we currently 

have a model of 2 explanatory variables. 

 

 
 

6. Specify the time course of the second predictor by clicking with the right mouse button in one of the yellow 

vertical segments. Click the “HRF” button to account for the hemodynamic delay of the fMRI signal. 

 

 
 

7. Repeat these steps for the remaining four conditions in the condition list. 

 

8. We have now defined our simple general linear model consisting of six predictors. You can inspect the 

specified reference function for each predictor by clicking the up or down spin of the “Predictor” spin control. 

You will see the time course of the first (1/6), second (2/6), …, sixth (6/6) predictor in the window. 
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9. You can see all predictors simultaneously by clicking the “Show all” checkbox. You can additionally visualize 
the protocol by also clicking the “Use protocol” check box. 
 

 
 

Info: If you made any error entering the predictors, you can use the “Clear Pred” button to set the values of 
the reference function of the currently selected predictor back to zero. To remove the currently selected 
predictor from the model, click the “Del Pred” button.  
 

10. As an exercise remove all predictors from the model, by clicking the “Del All” button. It is also possible to 
define all predictors of the model at once by clicking the “Define Preds” button, which can be helpful for 
complicated designs. As default BrainVoyager assumes that you have a baseline (or rest) condition explicitly 
defined as the first condition in your protocol. This baseline condition should not be included as a predictor 
in the design matrix of a general linear model. Therefore, when clicking the “Define Preds” button, the first 
condition (Faces_LVF) in the condition list is ignored and only five predictors will be defined.  
 
You can change this setting in the “Single Study GLM Options”. Please click on “Options” in the “Single 
Study General Linear Model” dialog and uncheck the option “Exclude first condition (“Rest”)”. Afterwards, 
click on “Define Predictors”.  
 

 
 
You will see that all six predictors are defined again.  
 

11. We now save the generated model to disk because we will need it later (see Step 13). Click the “Save...” 
button. In the appearing “Save As” dialog, enter “FacesHousesDesignMatrix.sdm” and click the “Save” 
button. The saved “SDM” file contains the time courses of the six defined predictors. 
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Info: When a GLM is computed by clicking the “GO” button, BrainVoyager also automatically saves an 
.sdm file, which would be in our case: sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS 
_THPGLMF3c_FMR_autosave.sdm. 

 
12. Now Click the “GO” button to run the GLM. The specified model is fitted to the time course of each pixel in 

all slices. The results of all individual model fits are saved internally in a glm data structure, from which 
statistical maps can be derived. 
 
After finishing the computation, a 

statistical “t” map of the “full model” 

is shown. The full model shows 

regions in red-to-yellow colors, 

where one of the predictors, a 

combination of the predictors or all 

six predictors together produce a 

significant effect (see figure on the 

right). Note the difference to a 

correlation test (or t-test) where 

only one individual comparison can 

be tested (see Step 4: Statistical 

Tests and Time Courses).  

 

 

 

Furthermore, the program will automatically invoke the Voxel Beta Plot showing the beta values for the voxel 

at the current mouse cursor position (see image above). The beta value represents the contribution of a 

predictor to the explanation of the time course of a voxel. You can also see the precise statistical value 

“below” the mouse cursor by looking at the status bar. 

 

 

13. You will see the map showing a lot of single activated pixels. They are not relevant to our experiment, and 
we will therefore set a cluster threshold to show only clusters of a certain size. Click on the menu item 
“Analysis” and choose the option “Overlay Volume Maps...” (or press CTRL+M). This will open the “Statistical 
Maps” dialog. In this dialog you will see the group “Cluster threshold”, with one spin box called “Size”. 
Change the default value of “1” to “4” and click the “OK” button. 
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Now the map should look much cleaner, like the image on the right.  
 
 
 
 
 
 
 
 
 
 
 
 

14. We can ask the computed GLM several “questions” with the help 
of the “Overlay GLM Contrasts” dialog. To invoke this dialog, click 
the “Overlay General Linear Model“ item in the “Analysis” menu. 
You will see a list of the six predictors, which we have defined in 
the “Single Study General Linear Model” dialog. 
 
 
 
 
 
 
 
 
Remark: Even with automatic naming, it is 
sometimes helpful to rename predictors. If you 
would like to do this, click on a predictor to make 
it the currently selected predictor. Then click the 
“Pred name” button, which will invoke the 
“Change Predictor Name” dialog. Now enter the 
new name for the predictor and then click the 
“OK” button or press the <return> key.
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15. On the left side of the predictor list, open squares 
are shown, which allow to select subsets of 
predictors. Click on the button “Clear Contrast” to 
clear all predictors. Now click on the square of 
predictor 1 to mark it with a plus sign (+). This 
corresponds to asking the GLM to show all brain 
regions that respond significantly to predictor 1 
“Faces_LVF” (where a significant amount of the 
variance of a voxel’s time course is explained by 
predictor 1). Now click the “OK” button. 

 
 
 
 
 
 
 
 
 
16. You will see that activity is now mainly in the right 

hemisphere (shown on the left side of the slices) 

since the first predictor corresponds to face 

images in the left visual field. 
 
 
 
 
 
 
 
 
 
 
 

17. Go back to the “Overlay GLM” dialog. Click the “Clear Contrast” button 
to remove any check marks from the predictor list. Check “Faces_RVF” 
with a plus sign and click the “OK” button. You will see activity mainly 
in the left hemisphere.  
 
 
Tip: To quickly invoke the “Overlay GLM” dialog, press CTRL+Y. 
Alternatively, click the “Increase Threshold” or the “Decrease 
Threshold” icon while holding down the CTRL key. 
 
 
 
 
 

18. Invoke the “Overlay GLM” dialog again. Click the “Clear contrast” 
button to remove any check marks from the predictor list. Check 
“Faces_ LVF” and “Faces_RVF” with a plus sign and click the “OK” 
button. You will now see activity in regions in which the two predictors 
together (their mean value) differs significantly from zero. 
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19. Go back to the “Overlay GLM” dialog. You can check a predictor not 
only with a plus sign (+) but also with a minus sign (-) by clicking again 
on a predictor which has already a plus sign. Check predictor 1 with a 
plus sign and predictor 5 with a minus sign. This creates a contrast 
asking for those brain regions where predictor 1 is more active than 
predictor 5. Click the “OK” button to see the result. Compare the 
outcome with the result of task 15 and try to explain the difference!  
 
 
 
 
 
 
 
 
 
 

20. Save the computed GLM under the 
name: “FacesHouses_FMR.glm” by 
using the “Save .GLM” button of the 
“Overlay GLM” dialog. We will be 
using this file in later steps. 
 
 
 
 
 
 
 
 

You can now move on to Step 7. 
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Step 7: Detailed GLM Analysis of Regions-of-Interest (ROI’s) 
 

In this step, we will apply the General Linear Model (GLM) to the time course of a selected region-of-interest 
(ROI). The “ROI GLM” tool produces statistical tables and graphs with detailed information about how well a 
chosen statistical general linear model fits to the data. It also provides results of specified contrasts for the data 
in the ROI. The tool works both for FMR documents and VTC based documents (introduced in Step 12) and is 
applied here to our preprocessed FMR data. 

 

1. If you have closed BrainVoyager, start the program now and open the document “sub-01_ses-04_task-
blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr”. 
 
To apply the ROI GLM tool, we need the time course of a region-
of-interest. To select a time course, we will first overlay a 
statistical map. Select “Overlay General Linear Model” in the 
“Analysis” menu. This will invoke the “Overlay GLM Contrasts” 
dialog. 
 
 

2. In the invoked dialog, load the General Linear 
Model “FacesHouses_FMR.glm” saved in Step 6 
by clicking the “Open” item in the local “File” 
menu. 
 
 
 
 
 

3. Now check both predictors “Faces_ LVF” and “Faces_RVF” with a plus sign. Click the “OK” button to 
overlay the statistical map on the EPI slices. Change the cluster threshold size to 4, as done in step 6. 
 

4. Now select a region-of-interest by dragging a rectangle around 
an active region. In the figure on the right, a ROI on the left side 
has been selected encompassing early visual areas of the right 
hemisphere. The appearing “ROI Signal Time Course” window 
shows the associated time course of the selected ROI. This time 
course is the average of the individual time courses of all 
included voxels. 
 
 
 
 
 
 

5. We can now apply the ROI GLM tool to the chosen time course. 
To get access to further options, right-click at any point in the 
“ROI Signal Time Course” window. This will show a context 
menu with further options. Select the “Show/Hide Options” item. 
As a shortcut to show/hide the advanced options, simply click 
with the left mouse button in the “ROI Signal Time Course” 
window. 
 
 
 

6. In the expanded “ROI Signal Time Course” dialog, click the 
“ROI-GLM” button. This will invoke the “ROI GLM Specifications” 
dialog.  
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7. In the “Correction / output options” section of the 
dialog, check “GLM graphs” and “GLM tables”, as 
well as “%-transform” of the time course. There 
are additional options producing information 
about serial correlations. For details about these 
options, consult the User’s Guide. Before we can 
run the GLM for the ROI time course, we have to 
specify a design matrix file. Click the “Browse...” 
button and select the file “FacesHouses 
DesignMatrix.sdm”, which we have saved in the 
previous step. This file contains the time courses 
for our six defined predictors.  
 
 
 
 
 
 

8. Before starting, we can also specify that we want 
to have analyzed contrasts. Switch to the 
“Contrasts” tab. To specify a contrast comparing 
stimulation in the left vs right visual field, check 
the “Faces_LVF” with a “+” and the “Faces_RVF” 
with a “-” sign by clicking once or twice, 
respectively. This contrast asks whether 
predictor 1 is significantly more (or less) active 
than predictor 5 within the chosen ROI. Now 
click the “Fit GLM” button, which will finally 
calculate the ROI GLM presenting the result in a 
table and a graph. 
 
 
 
 
 
 

9. One of the appearing windows shows the “ROI 
Time Course – GLM Results” tables.  

The first “ANOVA” table shows how well the 
chosen General Linear Model fits the ROI time 
course. The last row shows an overall value, the 
multiple correlation coefficient “R”, which can 
have values between 0.0 and 1.0. The value 
“R=0.850” indicates that our model fits very well 
to the data. 

 

 

The second “Predictor” table shows the so-called 
beta weights estimated by the GLM together with 
information about their significance. 

 

 

 

 

 

The third “Contrast” table shows that our 
specified contrast is significant in this ROI. 
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Note: There are more tables displayed in the same window, showing the GLM results after correction for 
serial correlations. In fMRI data, serial correlations are expected, i.e. high values are followed more likely by 
high values than low values and vice versa. These correlations lead to biased standard errors of the betas 
and hence to inflated test statistics. Therefore, it is important to correct for serial correlations and to focus 
on the test statistics after correction (for more information on serial correlations see the General Linear Model 
section in the User’s Guide). 
 

The “GLM Results” window is in HTML format and is saved automatically in the current folder as 
“ROI_GLM_Info.html”. If you want to keep the content of this file permanently, you might want to save it 
using another name, otherwise it will be overwritten next time when you invoke the ROI GLM tool in the 
same folder. To save the file you can use the “Floppy Disk” icon. 
 

10. A second and third window show the “GLM – Data, Model and Residuals” graphs without and with (II) 
correction for serial correlation. Both windows show three curves; the blue curve is the “data”, the time course 
from our selected ROI. It is the same curve as shown also in the “ROI Signal Time Course” window. The 
green curve is the “model”, it shows the “fit” of the GLM based on the six beta weights of our predictors. As 
you can see, the green curve rises and falls nicely with the blue “data” curve. The blue curve is, however, 
not “explained” completely by the green curve. This is also visible in the magenta curve, which represents 
the “residuals”. This curve is obtained by subtracting the model curve from the data curve and adapting these 
values for visualization purposes. 
 
Note: You can show or hide individual curves in the 
“Plot Options” dialog, which appears after clicking with 
the left mouse button into the graph window. The 
Options window is described at the end of the next step. 
You can save the graph by right- clicking in the window 
and choosing the “Save snapshot of plot” in the 
appearing context menu. 
 
 

11. You can close the graph and table windows by 
clicking the “x” buttons in the right upper corner. 
 
 
 
 

You can now move on to Step 8. 
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Step 8: Event-Related Averaging 
 
A helpful tool to visualize and compare effects of different experimental conditions is the event-related averaging 
plot. In this exercise, we will learn how to create templates for averaging time segments and how to apply them 
to time courses of any region-of-interest. If you continue directly from step 7, you can go now to point 2. 

 
 

1. If you have closed BrainVoyager, start the program now. 

Open the document “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr”. 
Since we will select regions-of-interest based on statistical maps later in this step, repeat (a part of) step 6 
now by computing (or loading) a GLM and by overlaying a GLM contrast with both predictors “Faces_LVF” 
and “Faces_RVF” marked with a plus (+) sign. 
 

2. Select “Event-Related Averaging” in the “Analysis” menu. 
This will invoke the “Event-Related Averaging Specification” 
dialog as shown below. 
 
 
 
 
 
 

3. In the “Event-Related Averaging 
Specification” dialog, you may add 
one or more runs by clicking the 
“Add Runs” button. This is often, 
however, not necessary since 
BrainVoyager places the current 
functional data file(s) automatically 
in the “Functional data files” list. For 
each added functional run (in our 
case just one), the program looks 
into the associated stimulation 
protocol file to get information 
about the different conditions 
including their names, colors and 
intervals. The extracted names are 
listed in the “Available conditions in 
referenced protocol files” box. In 
our case these are the condition 
names “Faces_LVF”, 
“Houses_RVF”, “Faces_CVF”, 
“Houses_LVF”, “Faces_RVF”, and 
“Houses_CVF”. 
 

In case a GLM has been computed 
or loaded, the dialog automatically 
adds all runs, which were used to 
compute the GLM. This is a very 
helpful function if you analyze data 
with many subjects and/or runs. 
 
 
 
 
 
 
 

Note: In principle, you can add additional FMR files allowing to average data from multiple runs. For FMR 
documents however, this requires that all runs are recorded in the same session, with the same slice 
parameters and were intra-session motion corrected. 
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4. Now we select one or more conditions, from 
which we want to average their associated 
time course epochs across repetitions. In this 
example we select all six conditions. 
 
 

5. When selecting condition names in the 
“Available conditions in referenced protocol 
files” list, the “Expected response plot” field 
presents an idealized expected response 
profile by plotting each condition in the color 
defined in the stimulation protocol. This plot is 
very helpful to adjust the values in the “Number 
of data points before and after onset of event” 
field. The “Pre” and “Post” values specify the 
number of time points before and after the 
onset of a stimulus condition used for 
averaging. The “Post” value should be large 
enough to see the entire time course but not 
larger than necessary to avoid the inclusion of 
subsequent events in the averaging. 
 
 
 
 

6. If the “Expected response plot” shows that the window is not large enough to include the whole condition-
related time course, increase the “Post” value in the “Number of data points before and after onset of event” 
field. Any change in the “Pre” and “Post” field will be immediately reflected in the plot of the expected time 
courses. You can play around with different numbers to see how the plot changes. In our example there is 
no need to change the default value of 16 time points, as this time window is long enough to “capture” the 
entire expected fMRI signal. 
 

 
 
Note: The height of the response for each condition is randomly chosen just to separate the curves from 
each other. To get a new random selection of the simulated response strength for each condition, simply 
click in the plot window. 
 

7. Now click the “Create AVG” button. In the invoked “Save As” dialog, enter “FacesHouses_1.avg” and click 
the “Save” button. 
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8. Now we can apply event-related averaging as specified and saved in the “FacesHouses_1.avg” file to any 
ROI time course. Use the left mouse button to select a rectangle encompassing a statistically significant 
region in the left hemisphere as shown below. 
 

  
 

9. Now, click somewhere in the appearing “ROI Signal 
Time Course” window, which will expand the dialog 
showing several options. One of these options is the 
application of event- related averaging files. Click 
the “Browse…” button in the “Event-related 
averaging” field (see figure on the right). In the 
appearing “Open File” dialog, select our saved file 
“FacesHouses_1.avg” and click “Open”. 
 
 
 
 
 
 
 
 
 
 
 

10. You will now see a new window on the screen called the “Event-Related Averaging Plot” or “AVG Plot” 
window. The “AVG Plot” window shows the result of averaging all time course epochs evoked by the same 
condition as indicated for the “Faces_RVF” condition below. The colors of the curves correspond to the 
condition colors assigned in the stimulation protocol. 
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11. To change the size of the AVG plot window, simply move the mouse cursor to the 
border of the window until it changes its shape to a sizing cursor. Then use the left 
mouse button to change the window size. The X axis is labelled “Time (scans)” in the 
plot reflecting the selection of “Volumes” resolution for time resolution in the “Event-
Related Averaging Specification” dialog. 
 
 

12. The displayed axes labels as well as many other options can be modified in the “Plot Options” dialog. To 
invoke this dialog, simply click with the left mouse button in the “Event-Related Averaging Plot” window. 
 

 
 
 
Exercise: Explore the options of this dialog. Check the “Horizontal arrangement” item to display the 
averaged curves side-by-side. Hide the error bars for the six curves by clicking each curve name in turn in 
the “Curve properties” list. After clicking on a curve name, you can change its display properties including 
color and curve size. Add a title by moving to the “Options” tab, checking “Enable” in the “Title” field and 
entering “Early visual areas – LH” in the “Label” edit box of the “Title” field. Change the separation of ticks 
on the X-Axis to 4 Try to achieve a display like the one shown below. 
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13. Since the program keeps the changes of the plot settings, you can select 
another ROI without having to change the plot layout again. Select a ROI 
in the right hemisphere as shown on the right. You will immediately see 
an update of both the “ROI Signal Time Course” window and the “Event- 
Related Averaging Plot” window as shown below. Note that the red and 
the light blue curve now show a strong response while the dark blue and 
yellow curve are essentially flat. This is the opposite from what we have 
seen in the previous “Event-Related Averaging Plot” window.  
 
 
 
 
 
 
 
 
Exercise: Correct the title from showing “LH” to showing “RH” instead. This correction has been made in the 
plot below. 
 

 
 
 
Note: If you want to display several “Event-Related Averaging Plot” windows at the same time, you must first 
display several “ROI Signal Time Course” windows using the CTRL button. For each “ROI Signal Time 
Course” window, invoke an “AVG Plot” window as described above. The settings from one AVG window do 
not transfer automatically to a newly created one, but you can change the settings in all open “AVG Plot” 
windows in the same way using the “Plot Options” dialog of each window. 
 

14. We will create a second .AVG file with a time resolution of seconds instead of volumes (scans). A time 
resolution of volumes is used by default showing the data in its recorded resolution. The recorded time 
resolution (volumes, scans) is characterized by the TR value, which is 2 seconds in our case. Sometimes it 
is convenient to present the data in a time resolution of seconds. Select “Event-Related Averaging” in the 
“Analysis” menu to invoke the “Event-Related Averaging Specification” dialog again. Our functional data file 
will be automatically added to the “Functional data files” list as before. Select the six main conditions in the 
“Available conditions in referenced protocol files” list.  
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15. In the “Resolution of data points” field, check 
now the “Seconds” option. With this option, the 
expected responses as well as later the 
averaged data will be shown in resolution of 
seconds. Since the real temporal resolution of 
the data is 2 seconds (the TR), the program 
will interpolate the ROI time course data to the 
higher resolution of seconds prior to 
averaging. 
 
 

16. Since we now have higher temporal 
resolution, the default settings in the “Number 
of data points before and after onset of event” 
field will not be adequate anymore. These 
values specify how many data points are used 
for averaging before and after the beginning of 
the stimulus event. Change the “Pre” value to 
“4” and the “Post” value to “32” seconds. 
 
 
 
 
 
 
 
 

17. We also adjust the “Average From:” value in the “Percent signal change” field to “-4”. Together with the 
“Average To:” value of “0”, these parameters define that the mean signal intensity of the 4 seconds before 
the beginning of every event are used as baseline for computing % signal change values. 
 
 

18. Another option is the possibility to compute either standard deviations or standard errors for each data point. 
The resulting values can be shown as “error bars” in an event-related averaging plot. Standard errors are 
the default option and it is recommended to keep that setting. Now click the “Create AVG” button to create 
the .AVG file and save it as “FacesHouses_2.avg”. 
 
Apply the saved AVG file to a region-of-interest as described before. You will see that the X axis is labeled 
“Time (sec)”, reflecting our specification of a “Seconds” resolution in the “Event-Related Averaging 
Specification” dialog. 
 

  
 
 
 

You can now move on to Step 9. 
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Part II: Analysis in Standard 3D Space - VMR-VTC Documents 
 

Step 9: Creating 3D Anatomical Documents from NIfTI Files 
 

In this step, we will learn how to create 3D anatomical documents from NIfTI files. The 3D data set will be used 
in the next step for coregistration with the functional data. As an alternative to the way described below, you 
can create new documents also from DICOM files via the “Document Creation Wizard” or via “Create Document” 
dialog as described in Appendix B: Creation of a 3D Anatomical Document. 
 
 
1. If you have closed BrainVoyager, start the program now and click on the “Open NIfTI icon” 

icon. Alternatively, go to “File -> Open NIfTI..” and navigate to 
“Documents\SampleData\GSGData\sub-01\ses-04\anat”. In this folder please select the 
file “sub-01_ses-04_acq-nondistorted_T1w.nii.gz” and confirm your choice by clicking on 
“Open”. 
 

 
 

2. The assembled images appear in the workspace in a so called VMR (Volume Magnetic Resonance) 
document and a file called “sub-01_ses-04_acq-nondistorted_T1w.vmr” will be automatically written to the 
derivatives folder of the “GSGData” project (Documents\SampleData\GSGData\derivatives\sub-01\ses-
04\anat). 
 

 
 
Note: BrainVoyager shows useful information from the header of the NIfTI file in the Info Pane. The first 
value of the “dim” entry indicates that it is a 3D dataset, with a matrix size of 256 x 256 (2nd and 3rd value) 
and 192 slices (4th value). Values 2 – 4 in the “pixdim” entry indicate the voxel size of 1 x 1 x 1 mm. If the 
voxels have different dimensions, BrainVoyager automatically proposes to interpolate the data set to iso-
voxel dimensions. In case the 3D data set is not scanned in sagittal slices, BrainVoyager will also propose 
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to change the orientation of the data set. 
 

 
 
The accompanied .json file that is in the same folder as the NIfTI file is automatically read and displayed in 
BrainVoyager when importing the NIfTI data. This file stores additional information about the data that 
cannot be found in the NIfTI header but might be useful for data interpretation. 
 

 
 
3. In order to adjust the brightness and contrast of the created document open the “Contrast and Brightness” 

dialog via “Options -> Contrast and Brightness …”. In this dialog you can change the brightness and contrast 
of the data set. As a rule of thumb, the grey matter intensity should be around 100, while the white matter 
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intensity should be between 120 - 160. Since the “Apply immediately” check-box is checked, you will see 
the VMR document changing immediately. By default BrainVoyager cleans the VMR, meaning that all voxels 
in the background will be set to an intensity value of 0, which corresponds to black. This improves different 
procedures, such as coregistration of data sets and brain peeling. Click the “OK” button to close this dialog. 
 

 
 
Note: If you would like to change the intensities at a later stage, you can use the menu option: “Volumes” -
> “Inhomogeneity Correction, V16 Tools...” to open the “16 Bit 3D Tools” dialog. In this dialog you would 
have to load the 16 bit version of the 3D dataset (sub-01_ses-04_acq-nondistorted_T1w.v16) via the button 
“Load.V16...”. 
 

4. You can explore this 3D data set by clicking with the left mouse button at any point within the “SAG”, “COR” 
and “TRA” view. This will define the “current” voxel highlighted by the white cross. The three views are 
automatically updated to show a sagittal, axial and coronal slice running through the specified 3D point. You 
can also change the position of the white cross by holding down the left mouse button while moving the 
mouse. To cycle through an enlarged view of the “SAG”, “COR” and “TRA” window, press CTRL + T multiple 
times. Notice that the intensity value and current position of the mouse cursor is shown in the Info Pane as 
well as in a small popup window next to the mouse cursor, even without clicking in the data set. 
 
Note: You can see that the data set is a bit inhomogeneous. Since intensity inhomogeneities in the image 
might have negative effects on the outcome of coregistration and segmentation procedures, we will improve 
the quality of the anatomical data set by applying an automatic intensity inhomogeneity correction. This 
becomes particularly important with data sets from ultra-high field scanners. 
 

5. First, open the “16 Bit 3D Tools” dialog by going to the “Volumes” menu and Select “Inhomogeneity 
Correction, V16 Tools...”. 
 

 
 

6. The automatic intensity inhomogeneity correction includes 4 steps: 
1) Background cleaning (all intensities of voxels in the background are set to 0) 
2) Brain extraction (the brain is segregated from the head tissue) 
3) White matter detection 
4) Bias field estimation within white matter voxels (voxels labeled as white matter are used to 

estimate the variability of white matter intensities across 3D image space) 
The white matter detection and bias field estimation is usually applied several times to improve the result; 
by default three times as indicated by the “No. of cycles:” entry in the “Intensity inhomogeneity correction 
(IIHC)” field. 
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2. Click the “GO” button to start the inhomogeneity correction. 
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For each step of the intensity inhomogeneity correction process, BrainVoyager saves one new file in the same 
folder as the original VMR sub-01_ses-04_acq-nondistorted_T1w.vmr. You can track the different processing 
steps that BrainVoyager applies to the VMR, as depicted in the images below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Resulting file: 
sub-01_ses-04_acq-
nondistorted_T1w_BrainMask.vmr 

Step 1 and 2: 
Background cleaning and 
Brain extraction 

Resulting file: 
sub-01_ses-04_acq-nondistorted 
_T1w_IIH-BiasField-1.vmr 

Step 3 and 4: 
White matter detection and 
Bias field estimation (1st cycle) 

Separation of white matter and 
grey matter before (blue) and 
after (yellow) the first bias field 
estimation and removal step 
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You can now move on to Step 10. 

Resulting file: 
sub-01_ses-04_acq-nondistorted 
_T1w_IIH-BiasField-2.vmr 

Step 5 and 6:  
White matter detection and  
Bias field estimation (2nd cycle) 

Separation of white matter and grey 
matter before (blue) and after (yellow) 
the second bias field estimation and 
removal step 

The result of all three cycles of the 
intensity inhomogeneity correction 
procedure is a more homogeneous and 
peeled VMR data set
sub-01_ses-04_acq-nondistorted_T1w 
_IIHC.vmr (and the corresponding V16 
file: sub-01_ses-04_acq-
nondistorted_T1w_IIHC.v16) 
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Step 10: Coregistration of Functional and Anatomical Data 
 
In this step, we will learn how to align functional slice-based data of an FMR document with a 3D data set. This 
allows us to relate brain activity more easily to anatomical locations and it prepares the transformation of the 
functional data into normalized (Talairach or MNI) space. In this step, we consider the case that the two data 
sets are recorded in the same session, which allows us to coregister them by using positioning information 
stored in the image file headers. Such a mathematical coregistration produces optimal results assuming no 
head motion takes place between the two measurements. After the position-based (mathematical) 
coregistration, small head motions can be corrected by manual or automatic fine adjustments. 

 
1. If you have closed BrainVoyager, start the 

program now.  
Open the file “sub-01_ses-04_acq-nondistorted 
_T1w_IIHC.vmr” by clicking its name in the Files 
Pane. 
 
Alternatively, you can use the “Open” icon or 
select the “File -> Open” menu item. In the 
“Open” dialog, navigate to the folder 
“SampleData\GSGData\derivatives\sub-01\ses-
04\anat”. Select the file “sub-01_ses- 04_acq-
nondistorted_T1w_IIHC.vmr” and click “Open”. 
 

2. We want to align our functional data recorded in 
the same session to this 3D data set. The 
necessary routines can be accessed from the 
“3D Volume Tools” dialog which appears 
automatically after opening a 3D data set. You 
can always show or hide this dialog by using the 
“3D Volume Tools” icon in the vertical toolbar of 
BrainVoyager. The dialog might be in “Mini 
Dialog” state when it appears. Use the button 
“Full Dialog>” to see the full dialog. The “3D 
Coords” tab is visible initially and shows, among 
other things, the coordinates of the current voxel 
(indicated by the position of the white cross) in 
the “System coords” field. Click the 
“Coregistration” tab to switch to the options we 
need for our task. 
 
 
 

3. Click the “Select FMR...” button in the “FMR-VMR coregistration” field.  
In the appearing “Open” dialog navigate to the folder “SampleData\GSGData\derivatives\sub-01\ses-
04\func”, select the file “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr” 
and click “Open”. 
 

 
 

4. To coregister the selected functional data with the loaded intra-session 3D data set, the program can use 
information from the headers of the raw data. This information is extracted automatically during document 
creation and is stored directly in the FMR and VMR files. 
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You will see that the document window has 
changed from a 2 x 2 display to a 2 x 3 display. 
The upper row shows the 3D data set and the 
lower row (coregistration row) shows the 
functional data (purple-blue) overlaid on the 3D 
data set. You will notice that the functional data 
is still in a different orientation than the 
anatomical data set. This will be corrected as 
soon as BrainVoyager has read the positioning 
information from the header.  
 
 
 
 
 

5. Click the “Align” button in the “FMR-VMR coregistration” field which will invoke the “FMR-VMR 
Coregistration” dialog. Note that BrainVoyager proposes file names for the transformation files (*.trf) holding 
the information of the Initial Alignment and Fine-Tuning Alignment. These “.trf” files will be saved after the 
alignment is finished and will be used later in Step 12 to transform the functional data and create VTC 
documents which offer the possibility to visualize functional information on a VMR. 
 

 
 

6. Click the “Source Options” tab. You will see that the “Invert intensity” option is checked in the “Options for 
FMR/AMR source” field which will lead to the functional data being visualized as anatomical data. 
Furthermore, the checkbox “Create edge display for FMR/AMR data” is marked. This setting will help to 
evaluate the quality of the alignment after the coregistration is done. 
 
Note: By default, BrainVoyager will also correct for inhomogeneities in the first volume of the FMR after the 
initial position information-based alignment has been performed. This will yield improved fine-tuning 
coregistration results especially for data sets with substantial inhomogeneities as the current example data. 
These inhomogeneities in the functional data also affect the visualization of statistical maps, therefore 
BrainVoyager will use the inhomogeneity corrected FMR automatically for visualization when opening the 
preprocessed FMR. Please consult the User’s Guide for more details on the functional inhomogeneity 
correction. 
 

7. To start the mathematical initial alignment and the 
gradient-based affine alignment (for fine-tuning) 
press the “GO” button.  
BrainVoyager will align the data using positioning 
information found in the header of the raw data 
(Initial Alignment), and by comparing the data 
sets on basis of their edges (Fine-Tuning 
Alignment). In gradient-based (affine) image 
registration, the rotation, translation and scaling 
parameters for each voxel are found via 
optimization. Each voxel will be transformed in the 
same way according to the parameters in the 
transformation matrix of the transformation file 
(*.trf). The previously specified transformation 
files (*.trf) will be saved to disk. 
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Note: After the initial alignment step and 
during the functional inhomogeneity 
correction you will see a display as shown 
on the right. In this view the functional data 
has been transformed into volume space, 
based on the positioning information saved 
in the FMR and VMR. The green box in the 
coregistration row shows the area in the 3D 
data set, i.e. volume space, where no 
functional data is available. This 
information is used for the functional 
inhomogeneity correction. 
 
 
 
 
 
Note: Fine-tuning alignment profits from edge information in the functional data set; using spatial smoothing 
during preprocessing however results in less anatomical or edge information in the functional images. This 
might result in a sub-optimal fine alignment of the functional and anatomical data as well as a constrained 
visualization of the functional - anatomical overlay in the coregistration dialog. Therefore, if you use spatial 
smoothing during FMR preprocessing, you should follow a slightly different pathway for aligning your 
functional and anatomical data:  
During FMR document creation BrainVoyager uses the first scan of the FMR to create a pseudo-anatomical 
image (or AMR) which is linked for display purposes to the FMR document. The AMR is not affected by the 
spatial smoothing step in the preprocessing routine and can therefore be used to improve the alignment and 
visualization of functional-anatomical overlay in case of smoothed data. Switch from the default option “Use 
FMR data (EPI slices)” to “Use linked AMR (coplanar T1 or T2 weighted slices)” in the “Source Options” tab 
before starting the coregistration procedure. This switch is not needed if you use a non-smoothed FMR for 
the coregistration. 
 

8. It is important to evaluate the coregistration 
by checking whether the coregistered 
functional data indeed matches the 
corresponding anatomical data. This can be 
done by browsing to various regions in the 
data set and by switching between different 
display views. The display option “Blend: 
Edges” is marked by default, which shows 
the “edge” display of the coregistered 
functional data in green overlaid on the 
anatomical data in the coregistration row. If 
the anatomical data is not clearly visible in 
the coregistration row, you can reduce the 
“Blend mode transparency” by clicking the 
“Options” button. 
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9. Click the “Blend: Mosaic” option for yet 
another view. Now you see a checkerboard 
pattern in the coregistration row with half of 
the checks showing the anatomical data and 
half of the checks showing the coregistered 
functional data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Since BrainVoyager 20.2 boundary-based registration is included for fine-tuning alignment. More 
information about this can be found in the User’s Guide 
(https://download.brainvoyager.com/bv/doc/UsersGuide/Coregistration/Boundary-BasedRegistration.html) 
 
 

10. Close the alignment result after evaluating its quality, as this coregistration visualization is not meant for 
further processing. 
 
 
 
 
 
 

You can now move on to Step 11 for MNI Transformation or to Appendix D for Automatic 
Talairach Transformation. 

https://download.brainvoyager.com/bv/doc/UsersGuide/Coregistration/Boundary-BasedRegistration.html
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Step 11: MNI Normalization of Anatomical Data 
 
In this step, we will learn how to normalize a recorded 3D data set into MNI space, which is a commonly used 
“standard” space for reporting locations of activated brain regions and for averaging data across subjects. 

 
1. If you have closed BrainVoyager, start the program now. Open the file “sub-01_ses-04_acq-nondistorted_ 

T1w_IIHC.vmr”. 
 

2. Select the “Normalize to MNI Template Space” option from 
the “Volumes” menu. 
 
 
 
 
 
 
 
 
 

3. Leave the options for the “Template-Based 
Normalization” as they are, unless your data set requires 
specific settings and click “GO”. In contrast to the 
Talairach normalization, no manual intervention is 
necessary. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. The VMR data has been normalized to the MNI-ICBM 152 template and is stored with a different name (sub-
01_ses-04_acq-nondistorted_T1w_IIHC_MNI.vmr). BrainVoyager will also automatically create the 
corresponding transformation files (*.trf), necessary for the transformation of the functional data into MNI 
space. 
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5. Using the “Show secondary VMR” option in the “Spatial Transf” tab of the “3D Volume Tools” allows to check 

the match of the transformed anatomy and the underlying template file (showing the contour of the 
transformed anatomy in orange). 
 

 
 

 
 
 
 

You can now move on to Step 12. 
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Step 12: MNI Normalization of Functional Data – Creation of VTC Documents 
 
In this step, we will learn how to transform our functional data into MNI space. The result of this process is a 
“VTC”’ file (VTC = volume time course), containing the data from a corresponding FMR document. For this 
purpose, we will use several pieces of information, which we have produced during previous steps, namely the 
intra-session anatomical and functional coregistration transformation matrix (“_IA.trf”, “_FA.trf”) and, finally, the 
MNI a12 transformation matrix (“_MNI_a12.TRF”) created during the anatomical normalization into MNI space. 
 
1. If you have closed BrainVoyager, start the program now and open the file “sub-01_ses-04_acq-

nondistorted_T1w_IIHC_MNI.vmr”. This is the anatomical data set we will use to display the functional data. 
 

2. Use the menu item “Analysis” -> “Create Normalized VTC from FMR Data...” to open the “Create VTC” dialog. 
The invoked “Create VTC” dialog contains several empty slots, which have to be filled to define the 
transformation “pipeline”. 
 

 
 

3. Click the “Browse” button on the right of the “Functional slice-based data file (FMR)” text box. In the appearing 
“Open” dialog, navigate to the “GSGData\derivatives\sub-01\ses-04\func” folder, select the file “sub-01_ses-
04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c.fmr” and click “Open”. This is the source file 
containing functional data. 
Since we would like to create a VTC in MNI space make sure that the radio button “To MNI“ is selected. 
 

4. Click the “Browse” button on the right of the “FMR -> VMR coregistration file 1, e.g. header-based (_IA.TRF)” 
text box. In the appearing “Open” dialog, select the file 
“sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c-TO-sub-01_ses-04_acq-
nondistorted_T1w_IIHC_IA.trf” and click “Open”. 
 

5. Click the “Browse” button on the right of the “FMR -> VMR coregistration file 2, e.g. fine-tuning (_FA.TRF)” 
text box. In the appearing “Open” dialog, select the file “sub-01_ses-04_task-blocked_run-
1_bold_SCCTBL_3DMCTS_THPGLMF3c-TO-sub-01_ses-04_acq-nondistorted_T1w_IIHC_FA.trf” and 
click “Open”. 
 

6. Click the “Browse” button on the right of the “12 parameter MNI transformation file (_MNI_a12.TRF)” text 
box. In the appearing “Open” dialog, navigate to the folder “GSGData\derivatives\sub-01\ses-04\anat” and 
select the file “sub-01_ses-04_acq-nondistorted_T1w_IIHC_TO_MNI_a12.trf” and click “Open”. 
 
 



Step 12: MNI Normalization of Functional Data – Creation of VTC Documents 

54

Note: The VTC creation process does not require that the functional data is transformed into a normalized 
space like MNI or Talairach. You can, for example, create a VTC file, which is only coregistered with the intra-
session 3D data set. For this you select the radio button “To Native“ and fill only the *_IA.TRF and *_FA.TRF 
file entries in the “Create VTC” dialog. Although it is possible to create a VTC in any 3D space, MNI as well 
as Talairach space allow to analyze data across subjects. For the analysis of several experiments from the 
same subject, however, it is fully valid to align all data sets to a 3D space other than Talairach, preferably 
ACPC space. The advantage of not going to Talairach or MNI space is that with rigid body transformations 
(only translations and rotations), the geometry of the cerebrum is not changed. In this case, select “To ACPC“ 
and fill all entries except the “Cerebrum border..” text box. 
 
 

 
 
 

7. After having specified these files, the “Resulting VTC file:” field shows the name of the VTC file that will be 
written to disk, it consists of:  

• the name of the originating FMR (“sub-01_ses-04_task-blocked_run-1_bold_SCCTBL 
_3DMCTS_THPGLMF3c”),  

• the target bounding box (“_256”, for 256 x 256 x256),  

• the interpolation used to transform the functional data to VTC space (“_trilin”, for trilinear),  

• the resulting voxel size (“_3x1.0”, for three times the resolution of the current VMR, which is 1.0 
mm iso-voxel. Therefore, the VTC data will have a resolution of 3.0 mm iso-voxel.)  

• and the resulting space (“_MNI.vtc”, for MNI standard space).  
The resolution of the functional data set that we use in the current tutorial is 2.0 mm iso-voxel. You can find 
this information in the FMR properties as described in step 1. Therefore, it makes sense to change the 
default resolution of three times the 1 mm VMR resolution to twice the VMR resolution. Please click on 
“Options” to open the “Create VTC Options” dialog and change the “Target resolution” to “2x2x2”. You can 
close the dialog via “OK”. 
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Note: you will see that the resulting “VTC file” entry has changed to: “sub-01_ses-04_task-blocked_run-
1_bold_SCCTBL_3DMCTS_THPGLMF3c_256_trilin_2x1.0_MNI.vtc” 
 

8. Click the “GO” button to start the transformation process. A progress dialog will appear to inform you about 
the ongoing computations: For each of the 291 time points/volumes, the 64 functional slices are coregistered 
with the intra-session 3D data set and then transformed into MNI space (see schema below). 
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Overview alignment and normalization 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

sub-01_ses-04_task-
blocked_run-1_bold_SCCTBL_ 
3DMCTS_THPGLMF3c-TO-sub-
01_ses-04_acq-nondistorted_ 
T1w_IIHC_IA.trf 
 
sub-01_ses-04_task-
blocked_run-1_bold_SCCTBL_ 
3DMCTS_THPGLMF3c-TO-sub-
01_ses-04_acq-nondistorted_ 
T1w_IIHC_FA.trf 

sub-01_ses-04_acq-nondistorted_ 
T1w_IIHC_TO_MNI_a12.trf 



Step 12: MNI Normalization of Functional Data – Creation of VTC Documents 

57 

9. We can connect or link the functional data in MNI 
space to the anatomical data set in MNI space. This 
linking possibility provides high flexibility. We can link 
the functional data from any experiment of a subject 
to a 3D data set and analyze across the functional 
data from different experiments. If all the data from the 
same subject has been transformed into MNI space, 
detected brain activity can be located reliably and 
precisely. In the “Analysis” menu, click the “Link 
Volume Time Course (VTC) file...” item, which invokes 
the “Link Volume Time Course (VTC)” dialog. 
 

10.  Click the “Browse...” button on the right of the “3D 
volume time course (VTC) file name” text box. In the 
appearing “Open” dialog, navigate to the 
“GSGData\derivatives\sub-01\ses-04\func” folder, 
select the file “sub-01_ses-04_task-blocked_run-
1_bold_SCCTBL_3DMCTS_THPGLMF3c_256_trilin
_2x1.0_MNI.vtc” and click “Open”. 
 

11. As default, the “Store reference to VTC file” item is 
checked after selecting a VTC file, which means that 
the data in that file is accessed from the file when 
needed. You can also check the other option “Load 
VTC into working memory”, which will load the 
complete data in the referenced file into memory. You 
should use this option only if the VTC file is not too big 
with respect to the installed working memory. Click 
the “OK” button to accept the link to the VTC file. 
 
 
 

12. There is no visible effect of establishing the link so far. 
Click with the right mouse button on an arbitrary 
position of the cerebrum. Click on “Show ROI time 
course”. A “ROI Signal Time Course” window will pop-
up showing the time course of our “Faces-Houses-
Left-Right-Center” experiment at the location selected 
with the mouse. This shows that the functional data is 
now indeed linked to the 3D data set. As we will see 
in the next step, we can now perform statistical tests 
and event-related averaging in the same way as we 
have done with the FMR document. 
 
Note: A more convenient way to get the ROI time 
course is by clicking with the left mouse button, while 
holding down the CTRL key. (CTRL+Left Mouse 
Button) 
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13. Another possibility to visualize the functional VTC 
data is provided, which is very important for 
checking whether the transformation was 
successful and whether anatomical and functional 
data are in good spatial alignment. Switch to the 
“Spatial Transf” tab of the “3D Volume Tools” 
dialog and click the “Show VTC Vol” button in the 
“Show a volume of attached VTC data” field. The 
anatomical images in the “SAG”, “COR” and 
“TRA” view will disappear and images from one 
volume of the VTC data will be shown instead. If 
everything went well during VTC creation, these 
images should be in good spatial registration, as 
indicated on the right. You can explore the 
depicted functional volume the same way as an 
anatomical volume by clicking and moving the 
white cross with the left mouse button. 
 
 
 
 
 
 

14. In order to see the anatomical images again, 
click the “Show primary VMR” option in the “Two 
VMR display options” field, or use the F8 key. 
With this function key, you can toggle between 
the anatomical and functional view. You can also 
blend the VTC volume with the anatomical 
dataset, by using the blend options. After having 
used the “Show VTC Vol” feature once, you can 
also save the functional volume as a VMR 
document to disk. In the “File” menu, click the 
“Save secondary VMR...” item. In the appearing 
“Save As” dialog, enter “sub-01_ses-04_task-
blocked_run-1_VTC_MNI” and click the “Save” 
button. 
 
Note: The performed task is similar to the 
creation of a pseudo-anatomical AMR 
document from functional slices of an FMR 
document. This allows you, for example, to 
visualize functional clusters over the VTC 
volume.  
 
 
 
 
 

15. You can “browse” to any location and check the correspondence between anatomical and functional data by 
clicking the “F8” key or by clicking the “Show primary VMR” or “Show Secondary VMR” option. With the 
“F9” key you can see both datasets blended in one view. The title bar of the “Volume” window shows the 
names of both loaded data sets, the name of the primary data set on the left side and the name of the 
secondary data set on the right side. 
 
Note: A VTC file contains a 4D data set: 3D space x 1D time. A “functional VMR” data set shows only one of 
many 3D volumes of the 4D data set. The “Show VTC Vol” function transforms by default the first volume of 
a linked VTC file into the VMR format. 
 
 
 

You can now move on to Step 13. 
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Step 13: Statistical Analysis of 3D Functional Data 
 
In this step, we will learn how to run statistical tests with VTC functional data. The good news is that this works 
in the same way as we have learned for slice-based (FMR) documents. We refer therefore to steps 4, 6 and 7 
and show here only a short summary of a GLM analysis. You will, however, learn about small differences in 
how to access time courses in 3D functional documents as opposed to slice-based FMR documents. 

 
 

1. If you have closed BrainVoyager, start the program now. Open the document “sub-01_ses-04_acq-
nondistorted_T1w_IIHC_MNI.vmr”. 
 

2. Link the VTC file “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c_ 
256_trilin_2x1.0_MNI.vtc” to the opened 3D data set (see step 12). If you have performed the previous step, 
you can click on the name of the VTC file in the Sidebar. 
 

3. Select “General Linear Model: Single Study...” in the “Analysis” menu. This will invoke the “Single Study 
General Linear Model” dialog. 
 

 
 

4. We load the simple six predictor model, which was saved in step 6. If you have not saved this file, go back 
to step 6 and create the model as described. Click the “Load...” button of the “Single Study General Linear 
Model” dialog and in the appearing “Open” dialog, navigate to the “GSGData\derivatives\sub-01\ses-
04\func” folder, select the file “FacesHousesDesignMatrix.sdm” and click the “Open” button. 
 

 
 

5. Click “GO” to run the GLM. After a few seconds, the statistical map of the full model is superimposed on 
the 3D data set. 
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6. You can now “browse” to any point in 3D space by clicking with the left mouse button in the “SAG”, “COR” 
and “TRA” view. You may also move the mouse while holding down the left mouse button, which will update 
the three views to show orthogonal planes through the “current” voxel. You will also see a “Voxel Beta Plot” 
window, which opens automatically. If you move the mouse over the brain (with or without pressing the left 
mouse button), the estimated beta values for the voxel under the mouse will be plotted in the “Voxel Beta 
Plot” and the t- and p-value for the current contrast map is shown in the popup window just below the mouse 
cursor. 
 

 
 

7. To inspect a time course of a certain region of interest, click with the 
right mouse button at any “hot” voxel as shown above. Then select 
“Show ROI Time Course” in the appearing context menu. As a faster 
method, simply CTRL-click a “hot” voxel. A “ROI Signal Time 
Course” window will pop up showing the time course of a small 
volume around the 3D coordinates selected by the mouse. The 
border of this volume is marked with a white line. The cluster is 
computed via region growing in 3D “statistical” space. You can 
control the maximum extent by changing the “Range” value in the 
“Options” field of the “3D Coords” tab of the “3D Volume Tools” 
dialog. If you use a range value of “1”, the time course of a single 
voxel will be selected when CTRL+clicking with the left mouse button 
in the “VMR” window.  
 

8. Since we need the computed GLM in a later step, we save it now 
to disk. Select the “Overlay General Linear Model...” item in the 
“Analysis” menu. 
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9. In the appearing “Overlay GLM Contrasts” dialog, click on “Save GLM...”. 
 

 
 

10. In the appearing “Save As” dialog, navigate to the folder “GSGData\derivatives\sub-01\ses-04\func”, enter 
“FacesHouses_VTC.glm” and click on “Save”. 
 

 
 

11. Now clear the contrast by clicking “Clear Contrast”. 
Afterwards check “Faces_LVF”, “Faces_RVF” and 
“Faces_CVF” with a plus sign (+) and “Houses_LVF”, 
“Houses_RVF” and “Houses_CVF” with a minus (-) and 
confirm your selection by clicking “OK”. BrainVoyager 
will compute a statistical 3D map showing brain regions 
that respond to face stimuli and will superimpose this 
map on the anatomical data, as shown below. 
 
 
 
 
 
 
 

 
 
Note: The 3D statistical map is internally stored in a VMP (volume map) data structure. Note that you can 
create many different VMPs from a single GLM file. VMPs can be created also with other statistical tests like 
linear correlation or t-tests.  
 

12. A VMP can also be saved to disk by using the “Overlay Volume Maps” item in the “Analysis” menu. In the 
appearing “Volume Maps” dialog, click the “Save As...” button. 
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13. Usually, you want to know some details about the 

activated clusters for publication purposes, e.g. the 
MNI coordinates and the t-value of the peak voxel of 
the respective clusters. This can be easily achieved by 
creating volumes of interest (VOIs) from all map 
clusters. We would like to focus on clusters of relevant 
size; therefore, we enable the “Cluster threshold” and 
set it to 12 functional (2x2x2 mm3) voxels in the 
“Statistics” tab of the “Volume Maps” dialog. Please 
note that this number is only a suggestion and 
depends on the details of your analysis. Now we can 
create VOIs from these clusters by clicking on the 
item “Convert Map Clusters to VOI(s)...” in the 
“Options” menu. 
 
 

14. In the appearing dialog you have to choose one of the two 
options: creating separate VOIs for all active clusters (“Create 
VOI for each cluster”) or creating one single VOI containing all 
significantly active voxels in the map (“Create one VOI from 
active voxels”). Since we want to get an overview of all 
distinguishable clusters and their statistical values, we select 
the former option. This dialog gives you the opportunity to 
restrict the minimal cluster size also for VOI creation. To do so, 
we enter 12 functional voxels (2x2x2 mm3) in the cluster 
threshold field, the same number that we have specified in the 
“Volume Maps” dialog. Click “GO” to start the VOI creation. 
 
 

15. After BrainVoyager has finished the computation, the “Volume-Of-Interest 
Analysis” dialog is invoked with a list of VOIs representing the activation 
clusters displayed in the statistical map. We might need the definition of 
these VOIs later again. Therefore, we save the VOI file by clicking on 
“Save”. Then we navigate to the folder “GSGData\ 
derivatives\sub-01\ses-04\func” and enter “Faces-Houses” in the invoked 
“Save VOI File” dialog. Now we have our map converted into VOIs, but 
we still don’t have any detailed information on the clusters. To obtain the 
required information about our regions of interest, we need to expand the 
“Volume-Of-Interest Analysis” dialog by clicking on the “>” button. 
 
 
 

16. Now click on the “Options” button and switch to the “VOI Functions” tab in the “VOI Analysis Options” dialog. 
There we can access, among other things, the peak voxel of each cluster with its associated MNI coordinates,  

 
its t-value and its p-value. Click on “Table ...” in the “VOI map peak voxels” field. 
 
 



Step 13: Statistical Analysis of 3D Functional Data 

63 

Remark: The information is displayed in a table that can be saved to disk. Furthermore, by marking one 
cluster and clicking on “Show Voxel” BrainVoyager automatically directs the white cross to the peak voxel 
of the respective cluster in the map. 
 

 
 
 
 

You can now move on to Step 14. 
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Step 14: Preprocessing of VTC Documents 
 
In this step we will learn how to preprocess VTC documents. By adding the preprocessing step of spatial 
smoothing only at the VTC stage and not at the FMR level, you will have the option to explore the effect of 
different spatial smoothing kernels on your data without having to recreate new VTC documents. 
 
1. If you have closed BrainVoyager, start the program, open the file “sub-01_ses-04_acq-nondistorted_T1w 

_IIHC_MNI.vmr” and link the VTC “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS 
_THPGLMF3c_256_trilin_2x1.0_MNI.vtc” by clicking its name in the “Recent Files” pane. 
 

2. Invoke the “VTC Data Preprocessing” dialog by selecting the entry with same name 
in the “Analysis” menu. 
 
 
 

3. Here we keep the default option of spatial smoothing but reduce the kernel size to twice the voxel resolution, 
i.e. 4 mm. The result of the spatial smoothing will be automatically saved to disc in form of a new VTC file 
called: “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL_3DMCTS_THPGLMF3c_256_trilin_2x1.0_MNI 
_SD3DVSS4.00mm”, as indicated in the “Output VTC” field. Start the preprocessing by clicking on “GO”. 
 

 
 
Note: The progress of the preprocessing step is indicated by a progress bar. After the spatial smoothing is 
finished, the resulting VTC document will be automatically linked to the current VMR. 
 

4. To explore the effect of spatial smoothing on your data analysis, please repeat 
points 3 -5 of step 13.  
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5. You will see that the resulting map looks 
smoother, more extended, but also less 
specific than the overall model map in step 
13 which was based on unsmoothed data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can now move on to Step 15. 
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Step 15: Event-Related Averaging of 3D Functional Data 
 
In this step, we will learn how to create templates for averaging time segments and how to apply them to time 
courses of any region-of-interest. Like with statistical tests, this works the same as in slice-based FMR 
documents. The only difference is that VTC files - instead of FMR files - will be used for the averaging procedure. 

 
1. If you have closed BrainVoyager, start the program now and open the document “sub-01_ses-04_acq-

nondistorted_T1w _IIHC_MNI.vmr”. Link the VTC file “sub-01_ses-04_task-blocked_run-1_bold_SCCTBL 
_3DMCTS _THPGLMF3c_256_trilin_2x1.0_MNI.vtc” to the opened 3D data set (see step 12). 
 

2. Select “Event-Related Averaging” in the “Analysis” 
menu. This will invoke the “Event-Related Averaging 
Specification” dialog. 
 
 
 
 
 
 
Our VTC, which we have linked above to 
the VMR document, will be automatically 
placed in the “Functional data files” list box 
and the condition names from the attached 
protocol will be listed in the “Available 
conditions in referenced protocol files” 
box. 
 
 
 
 
 
 
Note: You can add additional VTC files 
allowing to average across multiple runs 
from the same subject or across runs from 
different subjects. This requires only that 
all VTC files are in the same space, 
typically Talairach or MNI space. 
 
 
 
 
 
 
 
 

3. We now select conditions, from which we want to 
have their associated time course epochs 
averaged across repetitions. We select all six main 
conditions. The “Expected response plot” panel 
shows the predicted time course, which we can 
use to see whether the complete expected time 
course is visible or whether we need to increase 
the “Post” value. In the current example this value 
does not need to be changed. 
 
Note: You will see that the “Volumes” option in the 
“Resolution of data points” field is checked. This will 
show the averaged data in the recorded time 
resolution, as we will see shortly. The recorded time 
resolution (volumes, scans) is characterized by the 
TR value, which in our case is 2 seconds. 
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4. Now click the “Create AVG” button. In the 

invoked “Save As” dialog, navigate to the folder 
“GSGData\derivatives\sub-01\ses-04\func” and 
enter “FacesHouses_VTC.avg” and click the 
“Save” button. 
 
 

5. We can now apply event-related averaging as 
specified and saved in the .AVG file to any ROI 
time course. If you cannot see any activation at 
this point, run a GLM as described in step 13. 
Use the right mouse button to select a small 
volume encompassing a statistically significant 
region and its associated time course as shown 
on the right. 
 
 
 
 
 
 

6. In the appearing “ROI Signal Time Course” 
dialog, click in the plot which will expand the 
window showing several options. You can also 
expand the dialog by clicking with the right mouse 
button in the main window. In the appearing 
context menu choose the “Show/Hide Options” 
item. 
One of the appearing options is the application of 
event-related averaging files. Click the “...” 
button on the right side within the “Event-related 
averaging” field. In the appearing “Open File” 
dialog, select our saved file 
“FacesHouses_VTC.avg” and click “Open”. 
 
 
 
 
 
 
 
 

7. You will now see the “Event-Related Averaging 
Plot” window. As described in step 8, you can 
click into the window to access several options to 
change the appearance of the “Event- Related 
Averaging Plot” window. 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can now move on to Step 16. 
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Part III: Analysis in Surface Space - SRF-MTC Documents 
 

Step 16: Surface Reconstruction of the Head 
 
In this step, we will learn how to invoke the 3D Viewer. The 3D Viewer of BrainVoyager can be used to create 
advanced 3D renderings of the head and brain and to apply various surface-based methods like cortical 
flattening. Here we will learn how to create a 3D model of a subject’s head from a 3D MRI data set. The resulting 
visualizations are informative, but they are also important for advanced applications such as the spatial 
coregistration of an individual’s MRI 3D coordinate system with that obtained from other imaging modalities, like 
EEG or MEG. 

 
1. If you have closed BrainVoyager, start the program now. 

 
2. Click in the Files Pane on the file: “sub-01_ses-04_acq-nondistorted_T1w.vmr”. 

 
3. In the “3D Volume Tools” dialog, click on “3D 

Viewer” button when the dialog is still in mini-
state. If the “3D Volume Tools” is in full dialog-
state select the “3D Coords” tab and click the 
“3D Viewer” button. A new window called “3D 
Viewer” will be invoked allowing you to load and 
operate surface meshes. 

 
 
 
 
 
 
 
 
 

 
4. Click the “Create Sphere Mesh” icon in the “Mesh Tool Box” on the right side of the BrainVoyager window. 

The 3D Viewer will show a sphere, which is the mesh created as default. 
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5. Click the “Wrap-Volume Mesh Morphing” icon to start a “shrink-wrap” reconstruction procedure. The 

invoked process reduces the radius of the sphere until the vertices of the mesh “detect” tissue, which 
corresponds in our case to the skin of the subject’s head. The procedure iterates until the complete head is 
reconstructed as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 

6. You will notice that the created polygon mesh shows some “holes” in the surface of the head, to correct 
these flaws, we need to adjust the “Shrink mesh force to find VMR intensity”, i.e. the minimum intensity in 
the image that is considered to belong to the outer surface of the image, which is in our case the skull of the 
participant. Please open the “Mesh Morphing” dialog via “Meshes -> Mesh Morphing”. Select the “Find VMR 
mode”, change the value in the “VMR intensity” field to 10 and start the mesh morphing process by clicking 
on “GO”. 
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7. We now save the created polygon mesh. Click the “Meshes->Save Mesh As ...” menu item. In the appearing 
“Save As” dialog enter “sub-01_ses-04_acq-nondistorted_T1w_Head.srf” and click the “Save” button. 
 
 
 
 
 
 
 
 
 
 
 

You can now move on to Step 17. 
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Step 17: Navigation in the 3D Viewer 
 
In this step, we will learn how to navigate within the surface window. If you continue directly from the previous 
step, you can go to point 3 now. 

 
1. If you have closed BrainVoyager, start the program now. 

 
2. In the “Recent Files” Pane, click on the files: “sub-01_ses-04_acq-nondistorted_T1w.vmr” and “sub-01_ses-

04_acq-nondistorted_T1w_Head.srf”. Alternatively, you could load the files using the toolbar and menu. Click 
the “Open” icon or select the “File -> Open” menu item. In the “Open” dialog select the file “sub-01_ses-
04_acq-nondistorted_T1w.vmr” and click “Open”. Select the “Meshes” -> “Load Mesh” menu item. In the 
“Open” dialog, select the file “sub-01_ses-04_acq-nondistorted_T1w_Head.srf”. 
 

3. The program now displays a surface window as 
shown on the right. The window shows the 
surface reconstruction created in the previous 
step. With this mesh you can learn to navigate the 
camera position of the 3D scene also called the 
viewpoint. 
 
 
 
 
Click the right mouse button at an arbitrary 
point in the 3D Viewer, hold it down and move the 
mouse. You will see that the mesh moves left-
right and up-down as the mouse is moved left-
right and up-down. 
 
 
 
 
 
 
 
You can also move the viewpoint in the third 
dimension by holding down the left and right 
mouse button at the same time and by moving 
the mouse up and down. This movement of the 
viewpoint resembles “zooming” because the 
viewpoint is moved towards / away from the 
mesh. Alternatively use Shift + Ctrl + left click-
dragging for zooming.  
 
 
 
 
You can also rotate the viewpoint around the 
center of the scene by holding down the left 
mouse button and by moving the mouse left / 
right and up / down. This will rotate around two 
out of three possible axes. 
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4. A helpful tool to navigate in the 3D Viewer is the 
“Viewpoint Navigation” Panel. Press the 
corresponding button in the 3D Viewer toolbox to 
invoke it. This dialog offers 6 sliders that allow to 
change the three translation and rotation 
parameters just described. In addition, it offers six 
standard viewpoints, which you can apply by 
clicking the respective brain icons (“Left”, 
“Right”, “Top” etc.) on the left side of the dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: You can keep the dialog open and continue working in the 3D Viewer. 
 
 

You can now move on to Step 18. 
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Step 18: Slicing a Polygon Mesh 
 
In this step, we will learn how to slice a loaded or created polygon mesh. Sliced views of the head or brain 
provide useful information about the spatial relation of 3D renderings and the 2D images from which they have 
been built. If you continue directly from the previous step, you can go to point 3 now. 

 
1. If you have closed BrainVoyager, start the program now.  

 
2. In the Files Pane, open the files: “sub-01_ses-04_acq-nondistorted_T1w.vmr” and “sub-01_ses-04_acq-

nondistorted_T1w_Head.srf” by clicking on them. 
 

 
3. Click the “Mesh Slicing Panel” icon in the Surface toolbox. The “Mesh and 

Volume Slicing” dialog will open. You can use the checkmarks to activate the 
mesh slicing and the corresponding sliders to change the slice line in axial, 
coronal and sagittal mode. 

 
 
 
 
 
 
 

 
4. Activate the axial slicing. Click the 

checkmark next to the “TRA” slide. Now 
change the cut slice plane. The “TRA 
Slicing Mode” mode is automatically 
enabled when the “TRA Cut” mode is 
selected. Use the slider next to the 
“TRA” and see that the cut slice plane 
moves upward or downward, 
respectively. Hide the transparent 
rectangle around the slice by clicking 
the respective button in the “Mesh And 
Volume Slicing” dialog. 
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5. Besides transversal slicing, you can select sagittal and coronal slicing. 
Click the checkmarks next to the “COR” and “SAG”. A screen capture 
of the result is presented on the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. A cut shows one of two possible 
halves of the sliced object. You 
can also show the other half of 
the sliced object. Click the “Flip” 
checkmark next to the slider. 
You will see a scene like the one 
on the right, revealing the half of 
the object on the other side of 
the slice. You can do this with 
any of the three cut planes after 
having selected the respective 
slicing mode icon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: In BrainVoyager 21.4 the option of oblique slicing has been introduced, providing even more degrees of 
freedom for visualizing 3D renderings and the 2D images from which they have been built. This option can be 
enabled using the upper right button in the “Mesh And Volume Slicing” dialog. 
 

 
 
 

You can now move on to Step 19. 
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Step 19: Automatic Cortex Segmentation 
 
In this step, we will learn how to automatically segment and reconstruct the cortex of both hemispheres of the 
brain. 

 
1. If you have closed BrainVoyager, start the program now. If BrainVoyager is running, close any open 

document. 
 

2. Click the “Open” icon or select the “File -> Open” menu item. In the “Open” dialog, navigate to the folder 
“GSGData\derivatives\sub-01\ses-04\anat” folder. Select the “sub-01_ses-04_acq-nondistorted 
_T1w_IIHC_MNI.vmr” and click “Open”. 
 

3. Switch to the “Segmentation” tab of the “3D 
Volume Tools” dialog and then click the “Autom. 
Segm.” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. You will now see the “Automatic Cortex 
Segmentation and Reconstruction” dialog 
with a set of options, most of them are 
checked by default. Check the options 
“Create surfaces of outer grey matter 
(pial) boundary”, “Remove bridges LH“ 
and “Remove bridges RH“. Keep all other 
default settings and click the “GO” button. 
 
 
 
 
 
 
 
 
 
 
 
Several steps are now executed to properly segment the cortex along the white-grey matter boundary. The 
processes involve edge-preserving smoothing (sigma filter), filling of ventricles, application of masks to label 
subcortical structures, creation and analysis of intensity histograms to detect white and grey matter peaks, a 
region growing process and several small morphological operations. Finally, the hemispheres are 
disconnected and reconstructed. The segmentation can be further improved by removing topological errors 
(‘bridges’ and ‘handles’) via a bridge removal algorithm. After a successful segmentation of both hemispheres, 
they are saved to disk. Then the 3D Viewer is used to reconstruct and smooth the boundary of the cortex. 

 
 
 
 
 

Note: More details about these segmentation steps can be found in the User’s Guide and in Kriegeskorte & 
Goebel (2001). 
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5. During segmentation, a window displaying a set of histograms is shown. The different curves represent 
histograms for different axial slices. The left peak in the histograms corresponds to grey matter and the right 
peak to white matter. Another dialog appears allowing to adjust the white matter (WM) / grey matter (GM) 
cut point. If necessary, adjust the cut value in such a way, that the white line is between the two peaks and 
click the “OK” button. If the automatic segmentation has been completed, you can simply close the 
“Smoothed intensity histogram” window (as well as a second window with additional histogram information) 
by clicking the “Close” button (“x”) at the right upper corner. 
 

 
 
 
Info: The following files will be saved to disk during the segmentation process  
(“<MNI>” = “sub-01_ses-04_acq-nondistorted _T1w_IIHC_MNI”): 

 
 

<MNI>_WM_LH_(BL2).vmr The volume segmented at the white/grey matter boundary (WM) for 
the left hemisphere (LH), with topological errors removed (BL2) in 
case bride removal was selected. 

<MNI>_WM_RH_(BL2).vmr The volume segmented at the white/grey matter boundary (WM) for 
the right hemisphere (RH), with topological errors removed (BL2) in 
case bride removal was selected. 

<MNI>_WM_LH_RECO.srf The reconstructed surface mesh (RECO) of the left hemisphere (LH) 
without smoothing. 

<MNI>_WM_RH_RECO.srf The reconstructed surface mesh (RECO) of the right hemisphere (RH) 
without smoothing. 

<MNI>_WM_LH_RECOSM.srf The reconstructed mesh after smoothing (RECOSM), left hemisphere 
(LH); used as reference mesh. 

<MNI>_WM_RH_RECOSM.srf The reconstructed mesh after smoothing (RECOSM), right 
hemisphere (RH); used as reference mesh. 

<MNI>_WM_LH.srf An optimized mesh of the white/grey matter boundary (WM) for the left 
hemisphere (LH). 

<MNI>_WM_RH.srf An optimized mesh of the white/grey matter boundary (WM) for the 
right hemisphere (RH). 
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6. Since we have checked the “Create..pial” option, the program 
also creates and saves two VMR files named: “sub-01_ses-
04_acq-nondistorted_T1w_IIHC_MNI_GM_LH.vmr” and “sub-
01_ses-04_acq-nondistorted_T1w_IIHC_MNI_GM_RH.vmr” 
and two surfaces named: sub-01_ses-04_acq-
nondistorted_T1w_IIHC_MNI_GM_LH.srf” and “sub-01_ses-
04_acq-nondistorted_T1w_IIHC_MNI_GM_RH.srf”. When the 
process is finished, the 3D Viewer shows the reconstructed pial 
boundary (“GM”) of the right hemisphere. 
 
 
 
 
Note: The surfaces of the outer grey matter boundary are only for visualization purposes. For inflation and 
flattening we will use the reconstructed and smoothed white matter surfaces.  

 
7. We will now load the mesh: “sub-01_ses-04_acq-

nondistorted_T1w_IIHC_MNI_WM_LH_RECOSM.srf”, 
which was created during the automatic segmentation by 
selecting “Load Mesh..” in the “Meshes” menu. This 
mesh resembles a slightly dilated version of the 
grey/white matter boundary. 
Alternatively, you can use the “Load Mesh” icon in the toolbar 
to open an existing surface file (.srf). 
 
 
 
 
 
 
 
 
 

8. It is important to check the quality of the achieved segmentation. Once the 3D Viewer is selected, click the 
“Meshes -> Spatial Transformations...” menu item. In the appearing “Mesh Transformations” dialog, click the 
“Mesh -> VMR” button.  
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9. The program now automatically 
switches to the “Volume” window. 
The voxels that reflect the mesh in 
the 3D Viewer are shown in 
yellow. You can now navigate 
within the “SAG”, “COR” and 
“TRA” views to visually check 
whether the mesh contour 
matches the white/grey matter 
boundary.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: With most data sets, the achieved quality of the automatic segmentation procedure can be further 
improved. For assistance consult the Image Segmentation guides located on the BrainVoyager support 
website (https://support.brainvoyager.com/) for possible improvements including manual segmentation 
procedures. 
 
 
 
 
 
 

 

You can now move on to Step 20. 

https://support.brainvoyager.com/


Step 20: Cortex Inflation 

79 

Step 20: Cortex Inflation 
 
In this step, we will learn how to inflate a mesh, representing the cortical sheet, and how to show curvature 
information of the folded cortex on the inflated cortex representation. 

 
1. If you have closed BrainVoyager, start the program now. If BrainVoyager is running, close any open 

document. 
 

2. Click the “Open” icon or select the “File -> Open” menu item. In the “Open” dialog, select the file “sub-
01_ses-04_acq-nondistorted_T1w_IIHC_MNI.vmr” and click “Open”. 
 

3. Click on the “Meshes -> Load mesh…” menu item. In the appearing “Open” dialog, select “sub-01_ses-
04_acq-nondistorted_T1w_IIHC_MNI_WM_LH_RECOSM.srf” and click “Open”. 
 
Note: We use the “RECOSM” version of the reconstructed cortex and not the “WM” version. For the inflation 
process it does not matter which one is chosen, but for curvature coloring the “RECOSM” version is more 
appropriate than the “WM” version. 
 
Exercise: In this step, inflation is performed only for one hemisphere. As an exercise, you can run the same 
procedure for the other hemisphere. 
 

4. Click the “Mesh Morphing” menu item in the “Meshes” menu. 
 
 
 
 
 
 
 
 
 
 

5. In the appearing “Mesh Morphing” dialog, check the 
“Inflation mode” option in the “Morphing modes and 
forces” field. This will set appropriate default values for 
morphing forces and it will automatically specify the 
loaded mesh as the reference mesh. The reference 
mesh is used to keep the surface area constant while 
unfolding the cortex and the respective option “Keep 
surface area constant” is automatically enabled. The 
reference mesh can be also used for showing curvature 
information on the inflated cortex. 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. The inflation process is performed by repeatedly 
executing small morphing steps. The “Number of 
iterations” entry is set to “800” iterations. The “Update 
every: … Iterations” entry specifies that the screen 
(3D Viewer) will be updated every n morphing steps. 
Change the settings from 800 to 500 iterations and 
from 30 to 50 iterations and click the “GO” button to 
start the inflation process. 
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7. The screen will be updated repeatedly, 
showing the progression of the inflation 
process. On the right, you see the state 
of the inflation process after 171 
iterations. The next figure shows the 
state of the mesh after all requested 500 
iterations have been performed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Optional: Since there are still some folds visible (for example the central sulcus), we will run additional inflation 
steps. Invoke the “Mesh Morphing” dialog again and enter the value “300” in the “Number of iterations” entry. 
Keep all other settings and click “Go”. Now 300 more inflation steps are performed, further removing folds. 
 

 
 
Note: You can stop the inflation process by pressing the ESCAPE key. Depending on the speed of your 
computer, you might hold the ESCAPE key down for a few seconds to stop the process. You can easily 
restart the inflation process by clicking the “Morph Mesh” icon. 
 

9. We will now visualize curvature information from the folded cortex on the inflated representation, which al- 
lows to localize sulci and gyri. Invoke the “Background and Curvature Colors” dialog by selecting the 
respective item in the “Meshes” menu. There are two options to control the resulting curvature display. If the 
“Use two colors for convex and concave” option is clicked, one color will be used for concave (corresponding 
roughly to sulci) and another color for convex (corresponding roughly to gyri) regions. If the “Use graded 
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curvature colors (SMP-based)” option is checked (default), the degree of convexity or concavity is visualized 
by a whole range of colors. In this example we switch to the “Use two colors for convex and concave” option. 
Click the “Curvature” button in the “Calculate curvature” field. Then click on the “Smooth” button to slightly 
smooth the visualized contours. You can close the dialog by clicking on “OK”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. We now save the inflated cortex mesh. Click the “Save Mesh As ...” item in the “Meshes” menu. In the 
appearing “Save As” dialog, enter “sub-01_ses-04_acq-nondistorted_T1w_IIHC_MNI 
_WM_LH_RECOSM_INFL.srf” and click the “Save” button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can now move on to Step 21. 
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Step 21: Changing Mesh Colors 
 
In this step, we will learn how to change the two basic colors of a mesh. Optimized mesh colors can improve 
the visualization of statistical maps (see next step). 

 
1. If you have closed BrainVoyager, start the program now. If BrainVoyager is running, close any open 

documents. 
 

2. Click in the Sidebar on the file: “sub-01_ses-04_acq-nondistorted_T1w_IIHC_MNI.vmr” and “sub-01_ses-
04_acq-nondistorted_T1w_IIHC_MNI_WM_LH_RECOSM_INFL.srf”. 
 

3. You will now see the inflated hemisphere as saved in the last step. 
We will now change the color of the mesh to grey because 
functional data can be better visualized on a “neutral” background 
color. Click on the “Background and Curvature Colors” menu item 
in the “Meshes” menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. In the appearing dialog, click the “color display and selection” button to choose the “Default and convex 

color”.  
 

 
 
 

5. In the appearing “Color” dialog, enter the value “120” in the “Red:”, 
“Green:” and “Blue:” entries. Click the “OK” button to accept the new 
mesh color.  

 
 
 
 
 
 
 



Step 21: Changing Mesh Colors 

83 

6. A mesh has two default colors; the second is 
used during curvature coloring for visualizing 
concavely curved surface patches. To change 
the concave curvature color also to grey, click 
the corresponding “color display and selection 
button”. 
 

7. In the appearing “Color” dialog, enter the value 
“60” in the “Red:”, “Green:” and “Blue:” entries. 
Click the “OK” button to accept the new concave 
curvature mesh color. 
 
 
 
 
 
 

8. Back in the “Background and Curvature Colors” dialog change the setting again to “Use two colors for 
convex and concave”, click the “Curvature“ button, smooth the contours with the “Smooth” button and close 
the dialog with “OK”. You will now see that our inflated map has changed its color from blue to grey. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
9. Since we want to keep the grey coloring of the mesh, we now save the mesh to disk. Click the “Save Mesh 

...” item in the “Meshes” menu.  
 
 
 

You can now move on to Step 22. 
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Step 22: Statistical Maps on Cortex Meshes 
 
In this step, we will learn how to visualize statistical maps on inflated cortex meshes. We will also learn how to 
define surface patches as regions-of-interest, and to invoke time course plots for these regions. 

 
1. If you have closed BrainVoyager, start the program now. If BrainVoyager is running, close any open 

documents. 
 

2. Open the file “sub-01_ses-04_acq-nondistorted_T1w_IIHC_MNI.vmr” and load the mesh “sub-01_ses-
04_acq-nondistorted_T1w_IIHC_MNI_WM_LH_RECOSM_INFL.srf”. You will now see the inflated left 
hemisphere as saved in the last step. 
 

3. One way to create a new statistical map for a 
cortex mesh (SMP) is to convert a computed or 
loaded statistical map in volume space (VMP). 
Make sure that the VMR window is active (e.g. by 
clicking on the window title). Click the “Overlay 
General Linear Model” item in the “Analysis” 
menu. In the appearing “Overlay GLM Contrasts” 
dialog, click the “Load .GLM” button. In the 
appearing “Open” dialog, navigate to the 
“GSGData\derivatives\sub-01\ses-04\func” 
folder. Select the file “FacesHouses_VTC.glm” 
and click “Open”. Now check all six predictors 
with a plus sign or click on “Fill Contrast”. Next, 
click the “OK” button. 
 
 
 
 

 
 
Note: If you did not save the “Faces-Houses” GLM file in a previous step, recompute the GLM as described 
in step 13. 
 

4. Check if a statistical map has indeed been superimposed on the anatomical data. If you have the surface 
window maximized, click the “3D Volume Tools” icon, since this will switch to the “3D Volume” window. 
 

5. If the statistical map was superimposed on the data, click on the title of the 3D Viewer to switch back. 
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6. Before we can create a surface-based statistical map, we have to make 
sure that the inflated map is linked to the correct folded cortex 
representation, as described in previous steps. By default, the “RE- 
COSM” mesh is linked, and in the “Mesh Morphing” dialog you can check 
whether the correct link is established. Click the “Mesh Morphing” item 
in the “Meshes” menu and make sure that the “Use information from file:” 
field contains the file “sub-01_ses-04_acq-nondistorted_T1w_IIHC 
_MNI_WM_LH_RECOSM.srf”. 
 
 
 
 

7. Click the “Quit” button to close the “Mesh 
Morphing” dialog.  
 
 
 
Note: If no link to a folded mesh (RECOSM or WM) would have been established, the 3D coordinates of the 
inflated plane would be used to “sample” the functional data in the volume space. This would lead to useless 
results. In establishing a link to the folded cortex, the inflated map can “sample” the correct voxel space using 
the 3D coordinates of its vertices from the linked folded mesh. 
 

8. Now click the “Surface Maps” item in the 
“Meshes” menu. This will invoke the “Surface 
Maps” dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. We can create a surface map by clicking the “Create 
SMP” button. This procedure will create a statistical 
surface map (SMP) by sampling the voxel-based 
statistical map (VMP) at the vertex positions of the folded 
cortex mesh. The way this will be done can be specified 
in the invoked “Depth Integration” dialog. We will keep 
the default settings and close this dialog by clicking 
“OK”. Then click the “Close” button to close the “Surface 
Maps” dialog. You will now see several activation 
clusters super-imposed on the inflated map, most of 
them are in the temporal and occipital lobe. 

 
 
 
 
 
 
10. After linking a VTC to the VMR document, we can also inspect time courses for surface-defined regions-of-

interest (patches-of-interest, *.poi). An easy way to get a time course plot is by clicking on a “hot” (yellow or 
red) surface patch while holding down the CTRL key. You will see a “ROI Signal Time Course” window 
showing the time course of the selected surface patch. The boundary of the selected region is marked with a 
white contour line. 
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11. Close the “ROI Signal Time Course” window now by clicking the “Close” icon in the right upper corner.  
 

12. Now click the “Surface Maps” item in the “Meshes” menu to re-enter the “Surface Maps” dialog. The “SMP” 
list box shows the map we have created earlier. In this list, many maps can be available simultaneously, 
allowing to superimpose multiple maps, each with a different color range. To change the properties of a 
surface map, it must be selected by clicking with the left mouse button in the row of the respective surface 
map. If a surface map has been selected, several properties of it can be changed. Change the lower threshold 
of the surface map to a value of “3.0”. We will also slightly smooth the statistical map on the surface. For that 
you need to switch to the tab “Advanced” and click the “Smooth SMP” button. Click the “Close” button to 
close the dialog. You will see the changes performed as shown in the figure below. 
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13. It is helpful to see a voxel view and a surface view of the data at the same time. To achieve this, click the 
“Tile” item in the “Window” menu. This will arrange the “Volume” and the “Surface” windows side by side 
(with the active window docked to the left side of the screen). If you now also select a time course, you will 
at the same time have information about the location of your activation in MNI space as well as on a (inflated) 
cortex representation. In addition, you can access any ROI time course by clicking in either the “Volume” 
window or the “3D Viewer”. 
 

 
 

14. We now save the created (and slightly smoothed) surface map to disk. Click the “Surface Maps” item in the 
“Meshes” menu to re-enter the “Surface Maps” dialog. 
 

15. Click the “Save As...” button in the “Surface Maps” dialog. In the appearing “Save As” dialog, navigate to 
the folder “GSGData\derivatives\sub-01\ses-04\func”, enter “FacesHouses_LH.smp” and click the “Save” 
button. 
 

16. We can now load the saved surface map to any version of the same mesh, for example the folded one. 
Because an “SMP” is a statistical data file, you can use a surface map without having to have a voxel-based 
statistical map (VMP) present. Close the 3D Viewer by clicking its “Close” icon in the right upper corner. 
Relaunch the 3D Viewer by clicking the “3D Viewer” button in the “3D Volume Tools” dialog. 
 

17. We now load the folded left hemisphere. Click on the “Meshes -> Load Mesh” menu item. In the appearing 
“Open” dialog, select “sub-01_ses-04_acq-nondistorted_T1w_IIHC _MNI_WM_LH_RECOSM.srf and click 
“Open”. 
 
Exercise: Change the color of the folded mesh to grey, as described in step 21. 
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18. Click on the “Surface Maps” item in the “Meshes” menu. In the “Surface Maps” dialog, click the “Load” 
button. In the appearing “Open” dialog, navigate to the folder “GSGData\derivatives\sub-01\ses-04\func”, 
select the file “FacesHouses_LH.smp” and click the “Open” button. 
 
 
 
 
 
 
 
 

19. You will see a single entry in the SMP list box - the map we have saved earlier. If the square on the left side 
of the map entry is empty, click the square, which will fill the square with a “+” sign. Finally, click the “Close” 
button. 
 

 
 

20. You will now see the surface map on the folded cortex. 
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Alternative Pathways and Appendix 
 

Appendix A: Renaming DICOM Files 
 
The raw data of the “Faces-Houses-Left-Right-Center” experiment are stored in DICOM image format. Since 
DICOM files are named by the scanner in a complex way, it is often helpful to let BrainVoyager rename the files 
using information stored in the header of the images. This will avoid any potential problems during data import 
and the files will become easier to read. While the “Create Document Wizard” is doing this step automatically (if 
necessary), you can call this function anytime, e.g. before using the “Create Document” dialog. The usage of 
the “Rename DICOM Files..” dialog is shown below for the anatomical dataset. 

 
1. Select “File”->”Rename DICOM Files...” to invoke the 

“Rename DICOM Files” dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. In this dialog, click the “Browse...” button, and navigate to the 
“SampleData\GSGData\sub-01\ses-04” folder. Now select the 
“anat” folder and click the “OK” button. 
 
 
 
 
 
 

3. With the correct folder selected, click the “GO” button. The 
program will start renaming the files, which will be completed in 
a short time. The progress of the renaming is plotted in the “Log” 
Pane. 
 
 
 
 
 
 

Info: The names are changed to the format depicted in the 
screenshot. It is easily readable, showing a unique 
identifier provided by the experimenter, followed by three 
numbers indicating the <series>, <volume> and <image> 
of the data. Note that renaming does not change the 
content of the files. 
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Appendix B: Creation of a Functional Document from DICOM Files 
 

In this step, we learn how to create BrainVoyager documents from raw data. Documents can be created by 

using the “Create Document Wizard” dialog in the “File -> New Document Wizard” menu. Alternatively, you can 

use “File -> New Document”, which opens the “Create Document“ dialog with more advanced options for 

document creation. Because BrainVoyager supports the native file format of many scanner types, the data must 

be converted to BrainVoyager’s own file formats, so that all subsequent steps can be performed in the same 

way with all data. For the used sample data, original DICOM images are coming from a 3T Magnetom Prisma 

Fit scanner. 

 

1. Launch BrainVoyager by clicking the “BrainVoyager” icon. 
 
 
 

2. We will now begin importing the data into BrainVoyager by creating a document. Select “File -> New 
Document Wizard...” or click the “New Document Wizard” icon in the toolbar. 
 
 
 
 
 
 
 
 
 
 
 

3. The Document Creation Wizard will guide 
you through the creation process step by 
step. 
To start, click the “Next” button.  
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4. First choose the type of document you want to 
create. Toggle through all four possible selections, 
FMR, AMR, VMR and DMR and read their 
descriptions. For a functional document we thus 
have to choose an FMR document. It will contain 
the repeated measurements of the brain as it is 
scanned volume by volume during the execution 
of the “Faces-Houses” experiment. 
 
Click “Next” to continue. 
 
 
 
 
 
 
 
 
 

5. Choose the type of raw data format as “DICOM” 
and click “Next” to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Change the name of the document to “sub-
01_ses-04_task-blocked_run-1_bold”. To choose 
the source directory click “Browse” to navigate to 
the “GSGData\sub-01\ses-04\func” folder in the 
“SampleData” directory (e.g. C:\Users\ 
<USER>\Documents\BrainVoyager\SampleData), 
select any file within the directory and click “Open“. 
 
The wizard will detect if the names of your raw files 
have to be renamed into a more readable format. 
This is not necessary for our sample dataset. For 
more details about renaming DICOM files, please 
see Appendix A. 
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7. The Document Creation Wizard detects 
one set of DICOM files in this directory and 
determines from the header, what type of 
document it is and how many files it 
contains. 

Choose 
“JudEck_20181128_BI_Exercises_sess4-
0002-0001-00001.dcm (the only FMR 
present) and click “OK”. Note that 291 files 
(= volumes) have been detected. 
 

8. BrainVoyager selects automatically the 
first source file and reads all required 
information from the header, as for 
example the mosaic image resolution 
(800x800) containing the 8x8 individual 
slices (100x100 each) making up one 
complete volume of the brain measured 
at one timepoint. 
 
Click “Next” to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. In the next menu you can change the 

number of slices to 64, if not recognized 

correctly.   
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10. In this menu you can check the number of 
brain volumes detected (291). Since the first 
scans in a functional run contain data with very 
high intensity values (due to T1 saturation), it 
is recommended to skip a few volumes (e.g. 
2-4). However, for newer sequences this is 
already done during scanning. Therefore, it is 
not necessary to skip files for the example 
data set. Despite skipping volumes for 
analysis, BrainVoyager will use the first 
(skipped) volume for visualization since it 
contains more anatomical information than 
later volume scans.  
In addition, the user can already decide to link 
an existing protocol file at this point (if 
available). We will discuss the creation of the 
protocol file in step 3 of this guide. 
 
 
 

11. In the last menu the user has the option to save 
the resulting document in NIfTI format following 
the BIDS standard and to save this file to any 
existing or new project folder (see the section 

“The Faces-Houses-Left-Right-Center Tutorial” 

of this guide for a short explanation). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. The “Create Document Wizard” ends with an 
overview containing the most important settings. 
 
 
 
 
 
 
 
Click “Finish” to create the document. 
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13. If you would like to open the just created NIfTI file as an FMR document in BrainVoyager, please follow the 
instructions in step 1 and you will end up with a screen like the one shown below. 
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Appendix C: Creation of a 3D Anatomical Document from DICOM Files 
 

In this step, we will learn how to create 3D anatomical documents. The 3D data set will be used in the next step 
for coregistration with the functional data. As an alternative to the way described below, you can create new 
documents via the “Create Document” dialog (“File -> New Document...”). 

 
 

1. If you have closed BrainVoyager, start the program 
now and click on the “New Document Wizard” icon 
to open the “Create Document Wizard”. This time we 
create an anatomical document of the “intra-session” 
3D data set. “Intra-session” means that the 3D data 
set was recorded in the same scanning session as 
the functional data. 

 
 

2. Click “Next” to begin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. In the “Document Type” section, check VMR 
document as shown on the right. Click “Next” to 
continue. 

 
 
 
 
 
 
 
 
 
 
 
 

4. In the “Raw Data Format” section, select “DICOM” 
as file type and click “Next” to continue.  
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5. Enter the name of the document “sub-01_ses-
04_acq-nondistorted_T1w”. To choose the source 
directory, click on “Browse” to navigate to the 
“SampleData\GSGData\sub-01\ses-04\anat” 
folder. 

 
 
 
 
 
 
 
 
 
 
 
 

6. The Document Wizard automatically detects the 
set of DICOM files in this directory and determines 
what type of document it is and how many files it 
contains from the header of the files. Choose 
“JudEck_20181128_BI_Exercises_sess4-0008-
0001-00001.dcm” (the only VMR file present) and 
click “OK”. Note that 192 files (=slices) have been 
detected. 

 
 
 
 
 

7. The first source file is transferred to the 
appropriate field. BrainVoyager automatically 
detects the image resolution (256*256), typical 
for a T1 scan of the brain. 

 
 
 
 
 
 
 
 
 
 
 
 
 

8. In the next menu you can change the number of 
slices in case they were not recognized correctly. 
Check if the correct number of slices is entered 
(192). 
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9. This window offers the option to save the 
resulting document in NIfTI format following the 
BIDS standard and to save this file to any 
existing or new project folder (see the section 
“The Faces-Houses-Left-Right-Center Tutorial” 
of this guide for a short explanation). 

 
 
 
 
 
 
 
 
 
 
 

10. The Create Document Wizard ends with an 
overview containing the most important settings. 
Click “Finish” to build the NIfTI document. After 
the document creation is finished the assembled 
images will be temporarily shown in the 
workspace and the file “sub-01_ses- 04_acq-
nondistorted_T1w.nii.gz” will be automatically 
saved to disk. 
 
 
 
 
 
 
 
 
 
Note: BrainVoyager shows useful information about the data in the Info Pane, as found in the header of 
the first image. In our case the voxel size is 1 x 1 x 1 mm. 
 

 
 

 
11. If you would like to open the just created NIfTI file as a VMR document in BrainVoyager, please follow the 

instructions in step 9 and you will end up with a screen like the one shown above. 
 

Faces-Houses-Left-Right-Center#_The_


Appendix D: Automatic Talairach Transformation 

98

Appendix D: Automatic Talairach Transformation 
 
In this step, we will learn how to transform a recorded 3D data set into Talairach space, an alternative option to 
the MNI normalization described in step 11. 
 
1. If you have closed BrainVoyager, start the program now. Open the file “sub-01_ses-04_acq-nondistorted 

_T1w_IIHC.vmr”. 
 

2. Talairach transformation is performed in two major steps. In the first step, the cerebrum is translated and 
rotated into the AC-PC plane (AC = anterior commissure, PC = posterior commissure). In the second step, 
the borders of the cerebrum are identified; in addition to the AC and PC points and the size of the brain is 
fitted into standard space. These steps are performed in the “Talairach” tab of the “3D Volume Tools” dialog. 
Switch to the “Talairach” tab of the “3D Volume Tools” dialog. 
 

 
 
Note: Talairach transformation can be performed either automatically or manually. By default, the automatic 
Talairach transformation option is checked in BrainVoyager. However, for some non-standard data sets 
(e.g., lesion data, data sets from children or elderly) it might be advised to perform the Talairach 
transformation manually. This manual transformation procedure is described in Appendix E. 
 
Note: The 3D data set used here is recorded as sagittal slices and thus fits into BrainVoyager’s standard 
orientation. Data sets recorded axially or coronally must be “standardized” first, i.e. transformed to a sagittal 
orientation. Furthermore, it is advised to use brain-extracted datasets for the automatic Talairach 
transformation. 
 

3. Select the “Visualize intermediate results” checkbox and click on “Auto-ACPC-TAL”. This will initialize the 
automatic Talairach transformation. The “Visualize intermediate results” option gives you the opportunity to 
review all steps performed during the transformation process in the so called “Image Reporter”; a new 
window that is opened by BrainVoyager. Figures on the following page, labeled with Image Reporter, were 
copied from this additional review window. 
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Note: BrainVoyager automatically performs the following steps: 
It identifies the mid-sagittal plane (MSP) and uses this information to detect, segment and rotate the corpus 
callosum (CC), which is, in turn, removed to identify the fornix. The location information of the fornix is used 
to detect the anterior commissure (AC), which is the landmark that defines the origin of the Talairach 
coordinate system and will become the new center of the transformed data set. The figures below illustrate 
these steps. 

 
Image Reporter: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The x- and y-axes of the Talairach coordinate system are defined by the horizontal plane, connecting the 
AC and the posterior commissure (PC). The latter is identified by detecting the brain stem. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. After the AC and PC are specified, the 3D data 

set is translated and rotated into the AC-PC 
plane. This is indicated by a progress window, as 
shown on the right. 

 
  

Mid-Sagittal 
Plane (MSP) 

Sigma smoothed 
MSP 

Binarized MSP – 
iteration 2, 
threshold 170 

Binarized MSP – 
iteration 3, 
threshold 150 

Segmented 
Fornix 

Remove CC to 
detect Fornix 

Rotated CC Segmented CC 

Segmented BS Find Brainstem 
(BS) 

Estimated AC, 
PC, and 
posterior BS (red 
points) 
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5. After a few seconds, the transformation 
procedure is completed, and the resulting new 3D 
volume has been computed and saved to disk as 
sub-01_ses-04_acq-nondistorted_T1w_IIHC 
_aACPC.vmr. In addition, it is shown 
automatically in a new window. The “aACPC” in 
the new file name indicates that the 
transformation was applied automatically and 
that the brain is in the AC-PC plane. This can be 
seen clearly in the “TRA” view, which shows both 
the AC and PC point (see figure on the right). 
 
 
 
 
 
 
 
 
 
 
 
In the second automatic step of Talairach transformation, the 3D data set has to be transformed from ACPC 
space into Talairach space by specifying eight landmarks within the AC-PC transformed data set: AC, PC, 
AP (the most anterior point of the cerebrum), PP (the most posterior point), SP (the superior point), IP (the 
inferior point), RP (the most right point) and LP (the most left point). 
In order to identify those points, BrainVoyager cleans the background of the data set and removes non-brain 
tissue. Afterwards the image is binarized so that the background intensity is 0 (black) and the brain tissue 
has an intensity value close to 225 (white). 
 
Image Reporter: Binarized slices 
 
 
 
 
 
 
 
 
 
 
In a last step, BrainVoyager uses this binarized version of the original data set to detect the smallest and 
biggest coordinate for each axis of the coordinate system with an intensity value above 0, which corresponds 
to the following 6 landmarks: 
 
RP - smallest coordinate on x axis LP - biggest coordinate on x axis 
AP - smallest coordinate on y axis PP - biggest coordinate on y axis 
SP - smallest coordinate on z axis IP - biggest coordinate on z axis 
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All Talairach landmarks have now been specified. This 
information is used by BrainVoyager to change and fit the 
size of the brain to the size of the standard Talairach 
brain. This fitting procedure is done separately for 12 
subvolumes, which are defined by the 8 landmarks. After 
a few seconds, the resulting new 3D volume has been 
computed and saved to disk. In addition, it is also 
automatically shown in a new window (see figure on the 
right). The name of the new file is “sub-01_ses-04_acq-
nondistorted_T1w_IIHC_aTAL.vmr” and indicates that 
the data set is in Talairach space and that the automatic 
transformation procedure was used. 
 
 
 
 
 
 
 
 

6. The center of the new Talairach data set is still the AC point and the brain is still located in the AC-PC plane. 
The cerebrum’s size is, however, adjusted to fit into Talairach space. This can be easily tested by showing 
the Talairach grid over the new data set. The grid is shown by default when the transformation process is 
finished. In the “Talairach tab” of the “3D Volume Tools” dialog, you can choose whether you want to see the 
full or the partial grid, or no grid at all. Switch to the “Talairach tab” of the “3D Volume Tools” dialog. Check 
the “Display full grid” item in the “Specification and visualization of Talairach landmarks” field. 
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7. Another option to verify that the cerebrum’s size is correctly adjusted to Talairach space is to review the 
location of the landmarks. To do this, select a landmark in the drop-down list of the “Specification and 
visualization of Talairach landmarks” field, for example “LP”. The white cross will immediately jump to the 
respective coordinates. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

8. After Talairach transformation, the “3D 
Coords” tab also shows Talairach coordinates 
in addition to the system coordinates. You 
can test this by switching to the “3D Coords” 
tab and by clicking on any point in the data 
set. 
 
 
 
 
 
 
 
 
 
 
 
 
In total 7 new files are saved to disk during Talairach transformation: 
 
sub-01_ses-04_acq-nondistorted_T1w_IIHC_ToMSP.trf -> mid-sagittal transformation information 
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aACPC.trf -> ACPC transformation information  
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aACPC.vmr -> data set in ACPC space  
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aACPC.v16 -> 16bit data set in ACPC space 
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aACPC.tal -> list with the 8 Talairach landmarks  
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aTAL.vmr -> data set in Talairach space 
sub-01_ses-04_acq-nondistorted_T1w_IIHC_aTAL.v16 -> 16bit data set in Talairach space 
 
Remark: For details about the sub-steps performed during automatic Talairach transformation, please 
consult the User’s Guide. 
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Appendix E: Manual Talairach Transformation 
 
In this step, we will learn how to transform a recorded 3D data set into Talairach space, which is a commonly 
used “standard” space for reporting locations of activated brain regions and for averaging data across subjects. 

 
1. If you have closed BrainVoyager, start the program now. Open the file “sub-01_ses-04_acq-nondistorted 

_T1w_IIHC.vmr”. 
 

2. Talairach transformation is performed in two major 
steps. In the first step, the cerebrum is translated and 
rotated into the AC-PC plane (AC = anterior 
commissure, PC = posterior commissure). In the 
second step, the borders of the cerebrum are 
identified; in addition to the AC and PC points, the size 
of the brain is fitted into standard space. These steps 
are performed in the “Talairach” tab of the “3D Volume 
Tools” dialog. Switch to the “Talairach” tab of the “3D 
Volume Tools” dialog and switch from “Automatic” to 
“Manual” AC-PC transformation. 
 
 
 
Note: The 3D data set used here is recorded as sagittal slices and thus fits into BrainVoyager’s standard 
orientation. Data sets recorded axially or coronally must be “standardized” first. 
 

3.  Click the “Find AC Point…” button in the tab of 
the “3D Volume Tools” dialog. The “3D Volume 
Tools” dialog will be replaced by the “Find AC 
Point” dialog. You can directly move the cross by 
clicking the spin controls of the “Find AC Point” 
dialog. The most convenient, but still precise 
navigation method is using the cursor keys, try 
the left, right, up and down cursor key, as well as 
SHIFT-UP and SHIFT-DOWN. 
 
 
 
 
 
 
 
 
 

4. Now click the “OK” button in the “Find AC Point” 
dialog. The dialog will be replaced by the “3D 
Volume Tools” dialog and appropriate translation 
parameters (in the x, y, and z direction) will be 
specified for the AC-PC transformation. The 
display now also changes into a 2 x 3 
arrangement. The upper row shows the original 
data set, while the lower row shows the data set 
after the application of the specified 
transformation. 
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Note: You can inspect the defined translation parameters in the “Coregistration” tab of the “3D Volume Tools” 
dialog. The values in the “Translation” field reflect the shifts (x = 0.0, y = 14.0, z = 16.0) necessary to move 
the original center of the 3D data set to the AC point, which will become the new center of the transformed 
data set. If desired, you can fine-adjust the translation values further. 
 

5. After having specified the AC point, the “Find AC 
Point” button is disabled and the “Find AC-PC 
Plane...” button is enabled in the “Talairach” tab 
of the “3D Volume Tools” dialog. The next task is 
to rotate the data set in the coregistration window 
(lower row) in such a way, that we also see the 
posterior commisure in the axial slice. To find the 
posterior commisure, click the “Find AC-PC 
Plane...” button. The “Find AC-PC Plane” dialog 
will appear on the right side of the “VMR” window. 
 
 
 
 

6. Use the “x” spin control in the “Rotation” field to rotate the dataset in the lower row until the view shows the 
posterior commissure. The rotation is executed around the position of the green cross. Since the cross is 
located at the anterior commissure, it will remain visible in the coregistration window, despite the rotation. 
 

 
 

7. The green cross can be used to adjust two additional angles, if necessary. Change the “y” and “z” angle to 
rotate the dataset in the coregistration window, so that the green cross separates the left and right 
hemisphere of the brain. Now click the “OK” button in the “Find AC-PC Plane” dialog. 
 
Tip: It might be helpful to temporarily hide the green and white cross. Deselect the “Show cross” item in the 
“3D Coords” tab. More conveniently, you can also press the “A” key to display or hide the green / white cross. 
 
Info: The “Find AC Point” and “Find AC-PC Plane” dialogs provide a convenient way to specify the AC-PC 
transformation values. You can also do the same steps directly in the “Coregistration” tab. After you have 
placed the green cross on the AC, click the “Set Translation” button to fixate this point. If you click in the 
dataset afterwards, you can get back to the AC by clicking the “Center” button. Then adjust the rotation 
parameters by using the spin controls in the “Rotation” field on the “Coregistration” tab. 
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8. After having specified the AC-PC plane, the “Find AC-PC Plane” button is disabled and the “Transform to 
ACPC” button in the “AC-PC transformation” field of the “Talairach” tab is enabled. To save the specified 
transformation (translation and rotation values) and to apply them to the 3D data set, click the “Transform 
to ACPC...” button. 

 
9. After clicking the “Transform to ACPC...” button a 

“Spatial Transformation of VMR” dialog opens 
automatically. BrainVoyager will suggest the filename 
“sub-01_ses-04_acq-nondistorted_T1w_IIHC_ACPC”, 
which we will keep. It is used to name both the spatial 
transformation (TRF) file as well as the resulting VMR 
file. The TRF file specifies a desired spatial (rigid body) 
transformation, while the resulting VMR file is the result 
of the application of the spatial transformation. In order 
to save the TRF file and to create the resulting AC-PC 
aligned VMR file, click the “GO” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The specified spatial transformation is now 
applied to the data set. After a few seconds, the 
resulting new 3D volume has been computed and 
saved to disk. In addition, it is also automatically 
shown in a new window. The center of the new 
data set is now the AC point, and the brain is in 
the AC-PC plane. This can be seen clearly in the 
“TRA” view, which shows both the AC and PC 
point (see figure on the right). 
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10. In the second step of Talairach transformation, 
eight landmarks have to be specified within the 
AC-PC transformed data set: AC, PC, AP (the 
most anterior point of the cerebrum), PP (the 
most posterior point), SP (the superior point), IP 
(the inferior point), RP (the most right point) and 
LP (the most left point).  
 
Click on the “Talairach landmarks” list box in the 
“Specification and visualization of Talairach landmarks” field. 
In the opened list box, you will see some landmarks and a 
spin control. You can use the spin control to navigate to a 
desired landmark. The first landmark is “AC”, which does not 
need to be specified again. Select the “PC” landmark. This 
point is easy to find in the data set, because it must be in the 
same axial plane as “AC”. Note that BrainVoyager 
automatically jumps to a location in the vicinity of the PC. 
Press repeatedly SHIFT-DOWN to move the white cross from 
the AC point to the PC point (see figure on the right). 
 
 
 
 
 
 
 
 
 
 
 
 

11. Click the “Set point” button to define the 
“PC” point as the current location of the 
white cross. 
 
 
 
 

12. Select the “AP” landmark. Click the “Set 
point” button to define the “AP” point as the 
current location of the white cross. 
 
 
 
 
 
Tip: Although instructive, it is not necessary to set 
the AP point precisely in all dimensions. The only 
critical dimension is the y-axis or anterior-
posterior axis. The z-coordinate (superior-inferior 
dimension) and the x-coordinate (left-right 
dimension) are irrelevant. This holds true also for 
all remaining points - only one dimension is 
critical. 
 
Note: This is also the reason why Talairach 
transformation is performed in two steps: The AC-
PC rotation step has already matched the three 
orthogonal axes between the original data set and 
the final Talairach space, allowing to specify the 
landmarks, as described. It would be much harder 
to find the borders of the cerebrum correctly in an 
obliquely rotated brain. 
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13. Select the “PP” landmark. Click the “Set point” button to define the “PP” point as the current location of the 
white cross. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: You can easily verify and adjust the location specified for any landmark. To do this, select a landmark 
in the landmarks list, for example “AP”. The white cross will immediately jump to the respective coordinates. 
If you adjust the location of the landmark, do not forget to click the “Set point” button to accept the new 
coordinates. 
 
 
 

14. Select the “SP” landmark. Click the “Set point” button to define the “SP” point as the current location of the 
white cross. 
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15. Select the “IP” landmark. Click the “Set point” button to define the “IP” point as the current location of the 
white cross. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

16. Select the “RP” landmark. Please note that in BrainVoyager, MRI images are displayed in radiological 
convention. This means that LEFT is RIGHT and RIGHT is LEFT! Therefore, you need to locate “RP” on the 
left side of the image. In radiological convention, BrainVoyager shows an “R” symbol on the left side of the 
“COR” and “TRA” view to remind you of the reversal of left and right. After having located “RP” on the left 
side, click the “Set point” button. 
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17. Select the “LP” landmark on the right side of the cerebrum (see remarks above). After having located “LP”, 
click the “Set point” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

18. Now all Talairach landmarks have been specified. Since 
we will need this information later to transform our 
functional data into Talairach space, we save the list of 
defined landmarks to disk. Click the “Save .TAL...” 
button. In the appearing “Save As” dialog, make sure that 
the correct name is entered: “sub-01_ses-04_acq-
nondistorted_T1w_IIHC_ACPC.tal” and click the “Save” 

button. 
 
 
 
 
 

19. Up to now, we have only specified the landmarks, 
but the cerebrum is still in AC-PC space. To 
“warp” it finally into Talairach space, click the 
“ACPC -> TAL...” button. In the appearing 
“Talairach Transformation” dialog, make sure that 
the name “sub-01_ses-04_acq-nondistorted 
_T1w_IIHC_TAL.vmr” appears in the “File name” 
box within the “Resulting file(s)” field, and click 
“GO”. 
 
 
 
 
 
 
 
 
 
Note: The specified landmarks are now used to change the size of the brain in such a way that it fits into the 
size of the standard Talairach brain. This fitting procedure is done differently for 12 subvolumes, which are 
defined by the 8 landmarks. After a few seconds, the resulting new 3D volume has been computed and saved 
to disk. In addition, it is also automatically shown in a new window. 
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20. The center of the new Talairach data set is still the 

AC point and the brain is still located in the AC-PC 
plane. The cerebrum’s size is, however, adjusted 
to fit into Talairach space. This can be easily 
tested by showing the Talairach proportional grid 
over the new data set. Check the “Display partial 
grid” item in the “Specification and visualization of 
Talairach landmarks” field. The appearing grid is a 
reduced version of the full proportional grid, which 
you can also show by checking the “Display full 
grid” item. 
 
 
 
 
 
 
 
 
 

21. The “3D Coords” tab also shows Talairach 
coordinates in addition to the system coordinates. 
You can test this by switching to the “3D Coords” 
tab and by clicking on any point in the data set. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Remark: Please note that you might have defined slightly different landmarks for the Talairach transformation 
compared to the automatic definition of the landmarks. Therefore, you might notice some small, but negligible 
differences in the Talairach coordinates of significant voxels. 
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Appendix F: Data Analysis Manager 
 
A new addition to BrainVoyager is the so-called Data Analysis Manager. The aim of this tool is to create and 
preprocess multiple data sets at once. More information about how to use this tool can be found in the User’s 
Guide. 
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Appendix G: Defacing the VMR 
 
To satisfy data privacy and protection laws, e.g. the EU General Data Protection Regulation (GDPR), it may 
become necessary to remove facial features from the 3D anatomical dataset (VMR and surface mesh) – this will 
ensure that nobody can identify the subject from any of the data representations within BrainVoyager.  

 
From BrainVoyager version 21 on, we offer a “defacing” option for the VMR. Alternatively, users may already 
apply a defacing operation to their raw data if it is stored in DICOM format. 

 
1. The “Deface VMR…” option can be found in the “File” menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Open the file “sub-01_ses-04_acq-

nondistorted_T1w.vmr”, created in step 9. 
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3. Click the “Deface VMR” entry in the 
“File” menu and start the procedure. 
After several automatic steps, we 
receive a new VMR called “sub-
01_ses-04_acq-nondistorted 
_T1w_defaced.vmr”) with all facial 
features removed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. We test the result of the defacing in surface space by 
repeating the head mesh creation demonstrated in step 
16. 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. In the next screenshot, we compare the result of the head mesh reconstruction before (left side) and after 
(right side) the defacing. 

 

  
 
 



Appendix H: Summary of Keyboard Shortcuts 

114

Appendix H: Summary of Keyboard Shortcuts 
 

(different shortcuts for Mac OS X are indicated in blue) 
 

Keyboard and Mouse Functions in FMR documents 
 

Invoking time course plots 

Left-drag Shows time course plot for the selected region-of-interest in current time 

course plot window (only voxels above threshold). 

 
CTRL + Left-drag Shows time course plot for the selected region-of-interest in a new time course plot 

CMD + Left-drag window (only voxels above threshold). 

 
SHIFT + Left-drag Adds time course of selected region-of-interest to current time course plot 

window (only voxels above threshold). 

 
CTRL + R Saves or loads a region-of-interest. 

CMD + R 
 

Keyboard and Mouse Functions in VMR-VTC documents 
 

Invoking time course plots 
 

CTRL + Left-click Shows time course plot for the selected region-of-interest in current time course 

CMD + Left-click plot window.  

 
Display options 

‘A’ key Shows / hides the cross marking the current voxel. 

CTRL + ‘A’ key 

 
CTRL + Cursor Down Hides a statistical map, if present. 

CMD + Cursor Down 

(multiple times) 

 
CTRL + ‘T’ key Cycles through an enlarged SAG, COR, TRA and the standard 4-window view. 

CMD + ‘T’ key 
 

 
Translations and Rotations 

Cursor LEFT Moves cross along the X axis to lower system coordinate values 

(changes sagittal slice plane). 

 
Cursor RIGHT Moves cross along the X axis to higher system coordinate values 

(changes sagittal slice plane). 

 
Cursor UP Moves cross along the Z axis to lower system coordinate values (changes 

axial slice plane). 

 
Cursor DOWN Moves cross along the Z axis to higher system coordinate values 

(changes axial slice plane). 

 
SHIFT + Cursor UP Moves cross along the Y axis to lower system coordinate values (changes 

coronal slice plane). 

 
SHIFT + Cursor DOWN Moves cross along the Y axis to higher system coordinate values 

(changes coronal slice plane). 
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Two VMR data sets 
 

‘F8’ key Toggle between primary (‘<-’)and secondary (‘->’) VMR. In 3D-3D fusion mode, 

secondary VMR shows fused image (‘<->’ or ‘<=>’). 

 
‘F9’ key Cycle through fusion mode 1 (‘<->’), fusion mode 2 (‘<=>’) and standard non- 

fused view of VMRs. 
 

 
Keyboard and Mouse Functions in the 3D Viewer 

 
Mouse-driven translations and rotations 

SHIFT + Left-Move Translate camera horizontally and vertically moving the mouse left / 

right and up / down. 

 
CTRL + SHIFT + Left-Move Zooming. Move the mouse down (up) to move the camera towards (away) 

CMD + SHIFT + Left-Move from mesh. 

 
Left-Move Rotate around object’s Z axis (screen’s Y axis) by moving the mouse left / 

right (up / down). 
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General Keyboard Functions 
 
 

F1 User’s Guide 

 
CTRL + ‘N’ key Create Document dialog 

CMD + ‘N’ key 

 
CTRL + ‘O’ key Open File dialog 

CMD + ‘O’ key 

 
CTRL + ‘S’ key Save 

CMD + ‘S’ key 

 
CTRL + ‘W’ key Close File 

CMD + ‘W’ key 

 
CTRL + ‘Q’ key Exit BrainVoyager 

CMD + ‘Q’ key 

 
CTRL + “D” key Data Analysis Manager 

CMD + “D” key 

 
CTRL +’Shift’ key + ‘P’ key FMR Data Preprocessing 

CMD + ‘P’ key 

 
CTRL + ‘K’ key Link 3D Volume Time Course (VTC) dialog 

CMD + ‘K’ key 

 
CTRL + ‘G’ key Single Study General Linear Model dialog (when VTC is linked to 

CMD + ‘G’ key VMR) 

 
CTRL + ‘U’ key General Linear Model: Multi Study, Multi Subject dialog 

CMD + ‘U’ key 

 
CTRL + ‘Y’ key Overlay GLM Contrasts dialog 

CMD + ‘Y’ key 

 
CTRL + SHIFT + ‘A’ key ANCOVA dialog 

CTRL + CMD + ‘A’ key 

 
CTRL + ‘Shift’ key + ‘D’ key Overlay RFX ANCOVA Tests dialog 

CTRL + CMD + ‘D’ key 

 
CTRL + ‘R’ key Volume-Of-Interest Analysis dialog 

CMD + ‘R’ key 

 
CTRL + ‘M’ key Volume Maps dialog 

CMD + ‘M’ key 

 
CTRL + ‘Shift’ key + ‘O’ key Open SRF File dialog 

CTRL + CMD + ‘O’ key 

 
CTRL + ‘I’ key Patch-Of-Interest Analysis dialog 

CMD + ‘I’ key 

 
CTRL + ‘E’ key Surface Maps dialog 

CMD + ‘E’ key 
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